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1 About SafeGuard Enterprise
SafeGuard Enterprise is a modular security suite that enforces security for endpoints on a
cross-platform basis, using administrator-defined policies. SafeGuard Enterprise is easy to use
as system administration is carried out centrally in the SafeGuard Management Center.

The main protection functions of SafeGuard Enterprise on an endpoint are data encryption and
protection against unauthorized access through external media.

This document relates to Windows endpoints only. For Mac endpoints, see the SafeGuard
Enterprise for Mac user help under
www.sophos.com/en-us/support/documentation/safeguard-enterprise.aspx
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2 SafeGuard Enterprise modules
The availability of the features and functions listed below depends on the policies set by your
security officer.

■ Full disk encryption

All data on volumes specified by a policy (including boot files, swap files, hibernation files,
temporary files, directory information, etc.) are encrypted without the user having to change
the normal operating procedure or consider security.

■ BitLocker with pre-boot authentication managed by SafeGuard Enterprise

SafeGuard Enterprise manages the Microsoft BitLocker disk encryption engine. On UEFI
platforms, BitLocker pre-boot authentication is available with a SafeGuard
Challenge/Response mechanism whereas the BIOS version allows the recovery key to be
retrieved from the SafeGuard Management Center.

■ SafeGuard Power-on Authentication

SafeGuard Power-on Authentication (POA) requires you to authenticate before the
computer's operating system is started. After you do this, Windows starts and you are
logged on automatically. SafeGuard POA is available on Windows 7 endpoints only.

■ Synchronized Encryption

SafeGuard Enterprise allows you to protect your files whether they are located on your
computer, removable media, network shares, in the cloud, or on mobile devices. Any file
created with an application specified in a policy (for example, Microsoft Word) is encrypted,
irrespective of its location. For more information, see SafeGuard Synchronized Encryption
(page 13).

Whenever you send an email with one or more files attached, the system prompts you to
choose how to send the attachments. For more information, see Securely sending email
attachments (page 14).

■ File-based encryption

■ SafeGuard Data Exchange

SafeGuard Data Exchange offers easy data exchange with removable media without
re-encryption. Removable media such as external hard disks and USB memory sticks are
encrypted transparently.

■ SafeGuard File Encryption

SafeGuard File Encryption offers file-based encryption to securely store data on network
shares. Files in locations covered by File Encryption policies will be encrypted on-the-fly,
with no user interaction.

■ SafeGuard Cloud Storage
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SafeGuard Cloud Storage offers file-based encryption of data stored in the cloud. It ensures
that the local copies of your cloud data are encrypted transparently and remain encrypted
when they are stored in the cloud.
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3 Security recommendations
By adhering to the simple measures described here, you can keep data on your computer secure
and protected at all times. Follow these steps in particular when you use a laptop in public locations
like airports.

Choose strong passwords

Strong passwords are a vital part of protecting your data. Use strong passwords, especially for
securing the logon to your computer.

A strong password follows these rules:

■ It is long enough to be secure: A minimum of 10 characters is recommended.

■ It contains a combination of letters (upper and lower case), numbers, and special
characters/symbols.

■ It does not contain a commonly used word or name.

■ It is hard to guess but easy for you to remember and type accurately.

Change your passwords at regular intervals. Do not share them with anyone and do not write
them down.

Do not send passwords via email

Sending a password protected file and the password together in the same email is bad security
practice. Instead, use SMS or a phone call for sharing the password with the recipient.

Shut down your computer completely or put it into hibernation mode
when it is not in use.

On SafeGuard Enterprise protected computers, encryption keys might be accessible to attackers
in certain sleep modes where the computer's operating system is not shut down properly and
background processes are not terminated completely. Protection is enhanced when the operating
system is always shut down or hibernated properly.

When your computer is not in use or left unattended:

■ Avoid sleep (stand-by/suspend) mode as well as hybrid sleep mode.

■ Do not simply lock the desktop and switch off the monitor (or close the lid of your laptop), if
this is not followed by a proper shut down or hibernation. Setting an additional prompt for a
password when you resume working does not provide sufficient protection.

■ Instead, shut the computer down properly or put it into hibernation mode.

■ Make sure that the hibernation file resides on an encrypted volume (typically it resides on C:\).
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When the computer is hibernated or shut down properly, SafeGuard Power-on Authentication is
always activated the next time it is used, thus providing full protection.

Ensure that all volumes have a drive letter assigned

Volumes without a drive letter assigned may be excluded from encryption and thus leak confidential
data in plaintext.

To mitigate this threat:

■ If you find a volume without a drive letter assigned on your computer, contact your system
administrator.

■ Do not change drive letter assignments.
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4 Full disk encryption
Full disk encryption refers to the encryption of your entire hard drive. Whenever you log on to
your PC, you will have to enter user credentials; otherwise your PC is locked and your data cannot
be read.

SafeGuard Enterprise allows you to manage BitLocker. BitLocker Drive Encryption is a full disk
encryption feature with pre-boot authentication that is included with Windows operating systems.
It is designed to protect data by providing encryption for boot and data volumes. BitLocker is
available on endpoints with one of the following operating systems:

■ Windows 7 Enterprise / Ultimate

■ Windows 8/8.1 Professional / Enterprise

■ Windows 10 Professional / Enterprise

On Windows 7 (BIOS) endpoints, you can alternatively use SafeGuard Full Disk Encryption with
SafeGuard Power-on Authentication, see SafeGuard Power-on Authentication (Windows 7 only)
(page 59).

4.1 Encryption policies for BitLocker
The security officer can create a policy for encryption in the SafeGuard Management Center and
distribute it to the BitLocker endpoints where it is executed.

The BitLocker endpoints are managed transparently in the SafeGuard Management Center. The
same encryption policy can be used for Mac, BitLocker, and SafeGuard full disk encryption
endpoints. SafeGuard Enterprise knows the status of the endpoints and selects BitLocker
encryption accordingly.

4.2 Encryption keys for BitLocker
When the encryption policy is sent to a BitLocker-protected computer and before the computer
restarts and performs the initial encryption, the encryption keys are generated by BitLocker.
Depending on the system used, the behavior differs slightly.

Endpoints with Trusted Platform Module

Your security officer can define TPM, TPM+PIN, TPM+Startup Key, Startup Key, or Password as
the logon mode for BitLocker. If a logon mode with TPM is set, BitLocker stores its own encryption
keys in a hardware device called the Trusted Platform Module (TPM). The keys are not stored
on the computer’s hard disk.The TPM must be accessible by the basic input/output system (BIOS)
during startup. When you start your computer, BitLocker will get these keys from the TPM
automatically.
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Endpoints without Trusted Platform Module

If your computer is not equipped with a TPM, you will be prompted to either enter a password or
to create a BitLocker startup key using a USB memory stick to store the encryption keys. A dialog
displays the valid target drives on which to store the startup key.You will have to insert the memory
stick each time you start the computer.

For boot volumes, you must have the startup key available when you start your endpoint.
Therefore, the startup key can only be stored on removable media.

For data volumes, the BitLocker startup key can be stored on a boot volume that is already
encrypted. This will be done automatically, if the security officer has specified Auto-Unlock as
the logon mode for non-boot volumes. Otherwise, select a removable device that is displayed
under Valid target drives as storage location.

BitLocker recovery keys

For BitLocker recovery, SafeGuard Enterprise offers a Challenge/Response procedure that allows
information to be exchanged confidentially and the BitLocker recovery key to be retrieved from
the helpdesk, see Challenge/Response for BitLocker users (page 46) and BitLocker recovery key
(page 47).

To enable recovery with Challenge/Response, the required data has to be available to the helpdesk.
The data required for recovery is uploaded and saved in the SafeGuard Enterprise database.

Note:  If a BitLocker-encrypted volume in a computer is replaced by a new BitLocker-encrypted
volume, and the new volume is assigned the same drive letter as the previous volume, SafeGuard
Enterprise only saves the recovery key of the new volume.You need to back up the key of the
previous volume using the backup mechanisms offered by Microsoft.

4.3 Initial encryption on a BitLocker-protected endpoint
Depending on the logon mode the security officer specified for your endpoint, the behavior of
SafeGuard Enterprise BitLocker support differs slightly.

In any case you will be presented with a dialog that offers you the option to proceed with encryption
or to postpone it.

If you confirm that you want to save, restart and/or encrypt, encryption still does not start right
away. A hardware test is performed to make sure that your endpoint meets the requirements for
SafeGuard Enterprise BitLocker encryption. The system performs a reboot and checks whether
all hardware requirements are met. If, for example, the TPM or the USB memory stick is not
available or accessible, you will be asked to store the external key on a different device. The
system also checks whether you are able to provide the credentials correctly. If you cannot provide
your credentials, the computer boots anyway, but encryption will not start.You will be asked again
for your PIN or password. After a successful hardware test, BitLocker encryption starts.

If you select Postpone, encryption will not be started and you will not be asked again to encrypt
this volume until:

■ a new policy arrives,

■ the BitLocker encryption status of any volume changes, or
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■ you log on to the system again.

Note:  If BitLocker Drive Encryption is managed by SafeGuard Enterprise for your operating
system drive or fixed data volumes, do not turn on BitLocker manually for these volumes.

4.3.1 Save startup key

If your security officer specified TPM + Startup Key or Startup Key as the logon mode, you will
have to specify the location where the startup key is saved.We recommend using an unencrypted
USB memory stick to store the key. The valid target drives for the startup key are listed in the
dialog. Later, you will have to insert the storage device with the key each time you start the
computer.

Select the target drive and click Save and Restart.

4.3.2 Set password

If your security officer specified Password as the logon mode, you are asked to enter and confirm
your new password.You will need this password each time you start your computer. The length
and complexity that are required for the password depend on group policy objects your security
officer specified.You are informed about password requirements in the dialog.

Note:  If you use special characters in your password, take into account that the keyboard layout
you use might be different from the EN-US keyboard layout supported by BitLocker. Consider
setting your keyboard layout temporarily to EN-US for the purpose of setting the password, see
Change the keyboard layout (page 68).

4.3.3 Set PIN

If your security officer specified TPM + PIN as the logon mode, you are asked to enter and confirm
your new PIN.You will need this PIN each time you start your computer.The length and complexity
that are required depend on the group policy objects your security officer specified.You are
informed about PIN requirements in the dialog.

Note:  If your security officer enabled so-called enhanced PINs, you can use special characters
in your PIN.Take into account that the keyboard layout you use might be different from the EN-US
keyboard layout supported by BitLocker. Consider setting your keyboard layout temporarily to
EN-US for the purpose of setting the PIN, see Change the keyboard layout (page 68).

4.3.4 Dialog for TPM-only

If your security officer specified TPM as the logon mode, you just need to confirm the restart and
encryption of your endpoint.

4.4 Decryption with BitLocker
Computers encrypted with BitLocker cannot be decrypted automatically. Decryption must be
carried out using either BitLocker Drive Encryption in the Control Panel or the Microsoft
command-line tool Manage-bde.
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A policy in the SafeGuard Management Center determines whether or not you are allowed to
decrypt your BitLocker-encrypted volumes.
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5 SafeGuard Synchronized Encryption
SafeGuard Enterprise Synchronized Encryption is a versatile file encryption module that allows
you to encrypt sensitive data based on the application it was created with. See Application-based
file encryption (page 13). This encryption is persistent, so your data is secure even if moved to
another location, uploaded to a cloud storage provider or sent via email (see Securely sending
email attachments (page 14)).

Depending on the policy definitions specified by your security officer, certain file types are usually
encrypted automatically. However, in some cases it might be necessary to decrypt or encrypt
single files manually, see Encrypt/Decrypt files manually (page 13).

In Windows Explorer, encrypted files are marked with a green lock symbol.

Note:  If there are no overlay icons displayed, see Sophos knowledgebase article 108784.

5.1 Application-based file encryption
SafeGuard Enterprise Synchronized Encryption can encrypt any file created with an application
specified in a policy (for example, Microsoft Word), regardless of the file's location. A policy defines
a list of applications for which file encryption is executed automatically.

If your security officer has specified Microsoft Word as an application for which file encryption is
active, every file you create and/or save with MS Word is automatically encrypted with the default
Synchronized Encryption key. Anyone whose key ring includes this key can access your file.You
can copy the file to a network drive, a USB drive, or send it via email and it will still be encrypted.

Your security officer can define exemptions for specific locations via policy.

5.2 Encrypt/Decrypt files manually
Synchronized Encryption allows you to encrypt or decrypt individual files manually. Right-click a
file and select SafeGuard File Encryption. The following functions are available:

■ Show encryption state: Indicates whether or not the file is encrypted as well as the key used.

■ Encrypt according to policy: Encrypts your file with the Synchronized Encryption key under
the precondition that the file type is included in the application list and the location of the file
has not been excluded from encryption.

■ Decrypt selected file (only for encrypted files): Allows you to decrypt your file and store it in
plaintext. We recommend decrypting your file only if it does not contain any sensitive data.

■ Encrypt selected file (only for unencrypted files): Allows you to manually encrypt your file
with the Synchronized Encryption key.

■ Create password protected file: Here you can define a password to encrypt your file manually.
This is useful if you want to securely share your file with someone who does not have the
Synchronized Encryption key of your organization.Your file is encrypted and saved as an
HTML file.Your recipients can open the file with their web browser as soon as you communicate
the password to them.
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Note: This option is only available for files that are either plaintext or encrypted with a key
available in your keyring. If files are encrypted, they are first decrypted automatically before
they are password protected.

Note:  Password protection uses base64 encoding, therefore, files are bigger than the original
file. The maximum supported file size is 50 MB.

Note: You can only password-protect single files, not folders or directories. However, you
can select more than one file to show their encryption state and to encrypt/decrypt them.

If you right-click folders or drives, the following functions are available:

■ Show encryption state: Displays a list of the included files with icons indicating the encryption
state as well as the key used.

■ Encrypt according to policy: The system automatically detects all unencrypted files and
encrypts them with the default Synchronized Encryption key under the precondition that the
file type is included in the application list and the location of the file has not been excluded
from encryption. Depending on your policy, files encrypted with other keys may be re-encrypted
with the Synchronized Encryption key, too.

5.3 Securely sending email attachments
When sending email attachments to recipients who are using Synchronized Encryption, the
Synchronized Encryption key is used automatically.You do not need to worry about encryption
and decryption.

When sending emails to recipients outside your corporate network, you may want to encrypt your
attachments to protect sensitive data. SafeGuard Enterprise includes an add-in for Microsoft
Outlook that makes encrypting email attachments easy. Whenever you send an email with one
or more files attached, the system prompts you to choose how to send the attachments. The
available options may vary according to the encryption state of the files you attached to your
email.

■ Password protected

Select this option if you are sending sensitive files to recipients outside your organization. After
you define a password and press send, your file is encrypted and saved as an HTML file. If
you password protect several files at once, each file is encrypted separately with the same
password.

Note:  Password protection uses base64 encoding, therefore, files are bigger than the original
file. The maximum supported file size is 50 MB.

Note:  Files that are already encrypted are decrypted automatically before they are password
protected.

Recipients can open the file with their web browser as soon as you communicate the password
to them. We recommend that you use a strong password and don’t send it in the same email
as the files. We recommend that you give the recipients the password by phone or through
any other means of communication.

Recipients can use one of the following browsers to open the password protected attachment:

■ Microsoft Internet Explorer 11

■ Microsoft Edge
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■ Mozilla Firefox

■ Google Chrome

Note: This software has been tested with the browser versions available at the time of the
release.

Recipients can edit the file and send it back using the same password or a new password.
They are guided through the procedure by a wizard in their browser. For more information,
see Sophos knowledgebase article 124440.

■ Unprotected

Select this option only if your email attachment does not contain any sensitive data. Any case
in which you send email attachments unprotected may be logged and monitored by your
security officer.

■ Attachments to be sent unchanged

If the email contains attachments that cannot be password protected, you can either send
them unchanged or remove them from your email.The dialog contains a list of files that cannot
be protected for one of the following reasons:

■ The file is already password protected.You can either decrypt the file first and use a new
password, or you send the file unchanged and communicate the relevant password to the
recipient.

■ The file has been encrypted with a key that is currently unavailable in your keyring. The
key may have been temporarily revoked because of a security issue, or you do not own
the key used for encrypting the file. In this case, please ask your security officer.

Note: When you send an email to both internal and external recipients, the system handles the
email as if it were sent to external domains only.
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6 SafeGuard Data Exchange
Note: This module is not available on endpoints with Synchronized Encryption installed.

SafeGuard Data Exchange allows you to encrypt data stored on removable media that are
connected to your Windows computer, and exchange it with other users. All encryption and
decryption processes are run transparently and involve minimum user interaction.

Only users who have the appropriate keys can read the contents of the encrypted data. All
subsequent encryption processes are run transparently. Transparent encryption means that data
that has been encrypted and saved is automatically decrypted by an application when the data
is accessed again.

When you save the relevant file, it is automatically encrypted again. During daily work you will
not notice that the data is encrypted. However, when you disconnect the removable media, the
data remains encrypted and is protected against unauthorized access. Unauthorized users can
access the files physically, but they cannot read them without SafeGuard Data Exchange and the
relevant key.

Note: The behavior of SafeGuard Data Exchange on your computer is centrally defined by the
security officer.

In central administration, the security officer defines how data on removable media is handled.
The security officer can, for example, define encryption as mandatory for files stored on any
removable media. In this case, all unencrypted files existing on the device are initially encrypted.
In addition, all new files saved to removable media are encrypted. If existing files are not to be
encrypted, the security officer can choose to allow access to existing unencrypted files. In this
case, SafeGuard Data Exchange does not encrypt the existing unencrypted files. However, new
files are encrypted. So you can read and edit the existing unencrypted files, but as soon as you
rename them, they are encrypted. The security officer can also specify that you are not allowed
to access unencrypted files, and they remain unencrypted.

There are two ways to exchange encrypted files stored on removable media:

■ SafeGuard Enterprise is installed on the recipient's computer:You can use keys available
to both of you, or you can create a new key. If you create a new key, you have to provide the
data recipient with the passphrase for the key.

■ SafeGuard Enterprise is not installed on the recipient's computer: SafeGuard Enterprise
offers SafeGuard Portable. This utility can be automatically copied to the removable media in
addition to the encrypted files. Using SafeGuard Portable and the relevant passphrase, the
recipient can decrypt the encrypted files and encrypt them again without SafeGuard Data
Exchange being installed on their computer.

Important: When extracting a ZIP archive using the built-in archiver of Microsoft Windows the
process stops as soon as an encrypted file is encountered for which the key is not available. The
user receives a message that access was denied, but is not informed that there are files that have
not been processed and hence are missing. Other archivers, for example 7-Zip, work fine with
ZIP archives containing encrypted files.
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6.1 Settings for handling removable media
If SafeGuard Data Exchange is installed on your computer, removable media will be handled as
predefined by your security officer. A security officer can define the following settings for SafeGuard
Data Exchange (a combination of several settings is also possible):

■ Initial encryption of all files: In this case, encryption of all data on removable media starts
as soon as the device is connected to your computer. This setting ensures that the removable
media contain only encrypted data. When encryption starts, you are asked to select a key, or
a predefined key will be used.

■ User may cancel initial encryption: When initial encryption starts, a dialog is displayed that
allows you to cancel initial encryption.

■ User is allowed to access unencrypted files: If this option is set to No, SafeGuard Data
Exchange only accepts encrypted data on removable media. If unencrypted data exists on
removable media, the system will not allow you to access it. Only after encrypting the files will
you be able to access the data.

■ User may decrypt files: In this case, you can explicitly decrypt files on removable media. A
file that has been explicitly decrypted remains as plaintext on the removable storage medium,
if it is, for example, transferred to a third party.

■ User may define a media passphrase for devices:You are prompted to enter a media
passphrase the first time you connect removable media.

■ Plaintext folder: The security officer may define a plaintext folder that will be created on all
of your removable media. Files in this folder are not encrypted by SafeGuard Data Exchange.

■ User is allowed to decide about encryption: When you connect removable media to your
computer, a message box is displayed asking you whether you want to encrypt the files on
the attached media. In addition and if activated by policy, you can select if this setting should
be remembered and always be applied to the relevant media. If you select Remember setting
and do not show this dialog again, the message box will not be displayed again for the
relevant media. In this case, the new command Re-activate encryption becomes available
in the context menu of the relevant device in Windows Explorer. Select this command to revert
your decision about encryption for the relevant device. If this is not possible, for example
because you do not have the relevant rights for the device, an error message is displayed.
After you have reverted your decision, you are prompted to decide about encryption for the
relevant device again.

6.2 Single media passphrase for all removable media
connected to the computer
SafeGuard Data Exchange supports the definition of a single media passphrase that will give you
access to all removable devices connected to your computer. This is independent of the key that
is used for encrypting the individual files.

If specified, access to encrypted files can be granted by entering only one media passphrase.
The media passphrase is bound to computers for which you have logon permission. This means
that you use the same media passphrase on each computer.
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The media passphrase can be changed and will be synchronized automatically on each computer
you are working on, as soon as you connect removable media to this computer.

A media passphrase is useful in the following scenarios:

■ You want to use encrypted data on removable media on computers where SafeGuard Enterprise
is not installed (SafeGuard Data Exchange in combination with SafeGuard Portable).

■ You want to exchange data with external users: By providing them with the media passphrase,
you can give them access to all files on the removable media with one single passphrase,
regardless of which key was used for encrypting the individual files.

You can also restrict access to all files by only providing the external user with the passphrase
of a specific key (a "local key," which can be created by a SafeGuard Data Exchange user).
In this case the external user will only have access to files that are encrypted using this key.
All other files will not be readable.

Note:  A media passphrase is not necessary if you use SafeGuard Enterprise group keys to
exchange data on removable media within a workgroup where the members share such a key.
In this case - if specified by your security officer - access to encrypted files on removable media
is fully transparent.You do not have to enter a passphrase or password. This is because group
keys and media passphrases for removable media can be used simultaneously. Since the system
automatically detects an available group key, access for users sharing this key is fully transparent.
If no group key is detected, SafeGuard Data Exchange displays a dialog prompting the user to
enter a media passphrase or the passphrase for a local key.

Supported media

SafeGuard Data Exchange supports the following removable media:

■ Startup Keys

■ External hard disks connected by USB or FireWire

■ CD RW drives (UDF)

■ DVD RW drives (UDF)

■ Memory cards in USB card readers

6.3 Encrypting removable media
Encryption of unencrypted data on removable media either starts automatically as soon as you
connect the media to the system, or you have to start the process manually. All subsequent
encryption and decryption processes run transparently with nearly no user interaction.

6.3.1 Initial encryption

Encryption of unencrypted data on removable media either starts automatically as soon as you
connect the media to the system, or you have to start the process manually. If you are entitled to
decide whether files on removable media should be encrypted, you are prompted to do so when
you attach removable media to your computer.

To start the encryption process manually:
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1. Select SafeGuard File Encryption > Encrypt according to policy from the right-click menu
in Windows Explorer. If no specific key has been defined, a dialog is displayed for key selection.

2. Select a key, and click OK. All data contained on the removable media is encrypted.

The default key is used as long as no other key is set as the default. If you change the default
key, the new one is used for initial encryption of removable media that are connected to the
computer afterwards.

Note: To exchange data with users who have SafeGuard Enterprise installed on their computers
but do not use the same key as you do, local user-generated keys or a media passphrase are
required. These keys are also required for secure data exchange with users who do not use
SafeGuard Enterprise.You can identify local keys by their prefix (Local_).

If Encrypt plain files and update encrypted files is selected, encrypted files with an existing
key will be decrypted and encrypted again using the new key.

Cancelling initial encryption

If initial encryption is configured to start automatically, you may have the right to cancel initial
encryption. In this case, the Cancel button is activated, a Start button is displayed, and the start
of the encryption process is delayed for 30 seconds. If you do not click the Cancel button during
this time period, initial encryption starts automatically after 30 seconds. If you click Start, initial
encryption is started immediately.

Initial encryption for users with a media passphrase

If the usage of a media passphrase has been defined in a policy, you are prompted to enter the
media passphrase before initial encryption.The media passphrase is valid for all of your removable
media and is bound to your computer or to all computers for which you have logon permission.

Initial encryption will start automatically when you enter the media passphrase.

When you have entered the media passphrase once, initial encryption will start automatically
when you connect a different device to your computer.

Note:  Initial encryption does not start on computers where your media passphrase is not set.

6.3.2 Manual encryption

If you are entitled to decide whether files on removable media should be encrypted, you can start
the encryption process manually. Doing so you can also encrypt files already encrypted using a
different key.

To start the encryption process manually:

1. Select SafeGuard File Encryption > Encrypt according to policy from the context menu
in Windows Explorer. If no specific key has been defined, a dialog is displayed for key selection.

2. Select a key, and click OK. All data contained on the removable media is encrypted.

The default key is used as long as no other key is set as the default. If you change the default
key, the new one is used for initial encryption of removable devices that are connected to the
computer afterwards.
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Note: To exchange data with users who have SafeGuard Enterprise installed on their computers
but do not use the same key as you do, local user-generated keys or a media passphrase are
required. These keys are also required for secure data exchange with users who do not use
SafeGuard Enterprise.You can identify local keys by their prefix (Local_).

If Encrypt plain files and update encrypted files is activated, encrypted files with an existing
key will be decrypted and encrypted again using the new key.

6.3.3 Transparent encryption

If the settings defined for your computer specify that files have to be encrypted on removable
media, all encryption and decryption processes run transparently.

The files are encrypted when they are written to removable media and decrypted when they are
copied or moved from removable media to another file location.

Note: The data is only decrypted if it is copied or moved to a location for which no other encryption
policy applies.The data is then available at this location in plaintext. If a different encryption policy
applies to the new file location, the data is encrypted accordingly.

6.3.3.1 Media passphrase
If specified by a policy, you are prompted to enter the media passphrase when you connect a
removable device for the first time after the installation of SafeGuard Data Exchange.

If the dialog is displayed, specify a media passphrase.You can use this single media passphrase
to access all encrypted files on your removable media, regardless of the key that was used to
encrypt them.

The media passphrase is valid for all devices you connect to the computer.The media passphrase
can also be used with SafeGuard Portable and allows you to access all files, regardless of the
key that was used to encrypt them.

6.3.3.2 Change/reset media passphrase
You can change your media passphrase at any time using Change Media Passphrase from the
system tray icon menu. A dialog is displayed in which you enter the old and new media passphrases
and confirm the new one.

If you have forgotten your media passphrase, this dialog also provides an option to reset it. If you
select the Reset Media Passphrase option and click OK, you are informed that your media
passphrase will be reset at the next logon.

Log off immediately and log on again.You are informed that there is no media passphrase on
your computer and prompted to enter a new one.

6.3.3.3 Media passphrase synchronization
Note:  Media passphrase synchronization is available on Windows endpoints only.

The media passphrase on your devices and on your computer will be synchronized automatically.
If you change the media passphrase on your computer and connect a device that still uses an
old version of the media passphrase, you will be informed that the media passphrases have been
synchronized. This is true for all computers for which you have logon permission.
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Note:  After you have changed your media passphrase, you should connect all your removable
media with your computer.This ensures that the new media passphrase is used on all your devices
immediately (synchronization).

6.4 Exchanging data using SafeGuard Data Exchange
The following are typical examples of secure data exchange with SafeGuard Data Exchange:

■ Exchanging data with SafeGuard Enterprise users who have at least one key that is also
included in your key ring.

In this case, encrypt the data on the removable media using a key that is also included in the
recipient's key ring (for example, on his/her notebook).The recipient can use the key to access
the encrypted data transparently.

■ Exchanging data with SafeGuard Enterprise users who do not have the same keys as you do.

In this case, create a local key and encrypt the data using this key. Keys created locally are
secured by a passphrase and can be imported by SafeGuard Enterprise.You provide the
data's recipient with the passphrase. Using the passphrase, the recipient can import the key
and access the data.

■ Exchanging data with users without SafeGuard Enterprise

For users who do not have SafeGuard Enterprise installed on their machines, SafeGuard
Portable is available. To exchange data using SafeGuard Portable, local keys must also be
used in combination with a passphrase.

In addition, SafeGuard Portable has to be copied to the removable storage medium.You also
have to provide the recipient of encrypted data with the relevant passphrase. Using the
passphrase and SafeGuard Portable, the user can decrypt the encrypted files, edit them, for
example, and save them encrypted again on the removable storage medium. As SafeGuard
Portable is a self-sufficient application, no additional software needs to be installed on the
computer in order to access encrypted data.

Note: The security officer determines whether SafeGuard Portable is copied to removable media
in the security policy that applies to you.

6.4.1 Import keys from a file

If you have received removable media containing encrypted data or want to access Cloud Storage
data in a shared folder which has been encrypted using user-defined local keys, you can import
the key required for decryption to your private key ring.

To import the key, you need the relevant passphrase. The person who encrypted the data has to
provide you with the passphrase.

1. Select the relevant file on the removable media and click SafeGuard File Encryption > Import
key from file.

2. Enter the passphrase in the dialog that is displayed.

The key is imported, and you can access the file.
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6.4.2 Create local keys

1. Right-click the SafeGuard Enterprise system tray icon on the Windows taskbar or right-click
a volume/folder/file.

2. Click Create new key.

3. In the Create Key dialog, enter a Name and a Passphrase for the key.

The internal name of the key is displayed in the field below.

4. Confirm the passphrase.

If you enter a passphrase that is not secure, a warning message is displayed. To increase the
level of security, we recommend that you use complex passphrases.You can also decide to
use the passphrase despite the warning message. The passphrase also has to correspond
with the company policies. If it does not, a warning message is displayed.

5. If you opened the dialog using a right-click menu it contains the Use as new default key for
path option. With the Use as new default key for path option, you can set the new key
immediately as the default key for a volume or Cloud Storage synchronization folder.

The default key you specify here is used for encryption during normal operation. It will be used
until a different one is set.

6. Click OK.

The key is created and becomes available as soon as the data has been successfully
synchronized with the SafeGuard Enterprise Server.

If you define this key as the default key, all data copied to a removable storage medium or a
Cloud Storage synchronization folder from now on is encrypted using this key.

For a recipient to be able to decrypt all data contained on a removable storage medium, you may
have to re-encrypt the data on the device using the key created locally.To do so, select SafeGuard
File Encryption > Encrypt according to policy from the device's context menu in Windows
Explorer. Select the required local key and encrypt the data. This is not necessary if you use a
media passphrase.

6.5 Writing files to CDs using the Windows CD Writing
Wizard
SafeGuard Data Exchange allows you to write encrypted files to CDs using the Windows CD
Writing Wizard.

To do so, an encryption rule has to be specified for the CD recording drive. SafeGuard Data
Exchange adds a dialog to the CD Writing Wizard.There you can specify how the files are written
to CD (encrypted or plaintext).

Note:  If there is no encryption rule for the CD recording drive, files are always written to the CD
in plaintext.The SafeGuard Data Exchange dialog, where the encryption state of files to be written
to the CD can be specified, is not displayed.

After you have entered a name for the CD, the SafeGuard Removable Disk Burning Extension is
displayed.
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Under Statistics, the following information is displayed:

■ how many files are selected to be written to CD

■ how many of the selected files are encrypted

■ how many of the selected files are plaintext files

Under Status, the keys used for encrypting previously encrypted files are displayed.

For encrypting files that will be written to CD, the key that is specified in the encryption rule for
the CD recording drive is always used.

Files to be written to CD may be encrypted with different keys if the encryption rule for the CD
recording drive has been changed. If the encryption rule was deactivated when files were added,
the relevant plaintext files can be found in the folder for files to be copied to CD.

Encrypt files on CD

If you want to encrypt the files when writing them to CD, click (Re)Encrypt all files.

If necessary, previously encrypted files are re-encrypted, and plaintext files are encrypted. On
the CD, the files are encrypted using the key that was specified in the encryption rule for the CD
recording drive.

Write files to CD in plaintext

If you select Decrypt all files, the files are first decrypted and then written to the CD.

Copy SafeGuard Portable to optical media

If you select this option, SafeGuard Portable will also be copied to the CD.This allows the reading
and editing of files encrypted with SafeGuard Data Exchange without having SafeGuard Data
Exchange installed.

6.5.1 Write CDs/DVDs

Windows provides a CD Writing Wizard for CDs/DVDs.

The SafeGuard Disc Burning Extension for the CD Writing Wizard is only available for burning
CDs/DVDs in Mastered format.The wizard is only displayed if files are to be written on CDs/DVDs
in Mastered format.

For the Live File System, no Recording Wizard is required. In this case, the recording drive is
used like any other removable media. If there is an encryption rule for the recording drive, the
files are encrypted automatically when they are copied to a CD/DVD.

6.6 SafeGuard Portable
Using SafeGuard Portable, you can exchange encrypted data on removable media with recipients
who do not have SafeGuard Enterprise installed on their machines.
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Note:  SafeGuard Portable is not supported on Mac OS X.

Data encrypted with SafeGuard Data Exchange can be encrypted and decrypted using SafeGuard
Portable.This is achieved by automatically copying a program (SGPortable.exe) to the removable
media.

Note:  SafeGuard Portable only encrypts or decrypts files encrypted with AES 256.

Using SafeGuard Portable in combination with the relevant media passphrase gives you access
to all encrypted files, regardless of which local key was used for encrypting them.The passphrase
of a local key only gives you access to files that have been encrypted using this specific key. The
recipient can decrypt encrypted data and encrypt it again.

Note: The media passphrase or the passphrase of a local key has to be communicated to the
recipient beforehand.

The recipient can use existing keys created with SafeGuard Data Exchange for encryption, or
create a new key with SafeGuard Portable (for example, for new files).

SafeGuard Portable does not have to be installed on or copied to your communication partner’s
computer. It remains on the removable media.

Note:  As a SafeGuard Enterprise user, you usually do not need SafeGuard Portable.The following
description assumes that users do not have SafeGuard Enterprise installed on their computer
and therefore have to use SafeGuard Portable to edit encrypted data.

6.6.1 Editing files using SafeGuard Portable

You have received removable media containing files encrypted with SafeGuard Data Exchange,
along with a folder named SGPortable. This folder contains the file SGPortable.exe.

1. Start SafeGuard Portable by double-clicking SGPortable.exe.

Using SafeGuard Portable, you can decrypt the encrypted data on the removable media and
then re-encrypt it. SafeGuard Portable offers functionality that is similar to Windows Explorer.

In addition to the file details known from Windows Explorer (name, size, etc.), SafeGuard
Portable shows the Key column.This column indicates whether the relevant data is encrypted.
If a file is encrypted, the name of the key used is displayed.

Note: You can only decrypt files if you know the relevant passphrase for the key used.
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2. To edit files on the removable media, click on the relevant file and choose the relevant command
from the context menu (with a right-click) or from the File menu.

The following menu commands are available from the context menu:

Opens the Enter Key dialog. In this dialog, you can
generate an encryption key with SafeGuard
Portable.

Set Encryption Key

Encrypts the activated file on your removable
media. The last-used key is used for encryption.

Encrypt

Opens the Enter Passphrase dialog. Enter the
passphrase for decrypting the selected file in this
dialog.

Decrypt

Displays a dialog and shows the file's encryption
state.

Encryption State

Copies the file to a folder of your choice and
decrypts it.

Copy to

Deletes the activated file from your removable
media.

Delete

You can also select the commands Open, Delete, Encrypt, Decrypt and Copy with the icons
shown on the toolbar.

6.6.1.1 Set encryption keys
To encrypt a file on removable media, and create an encryption key:

1. From the context menu or from the File menu, select Set Encryption Key.

The Enter Key dialog is displayed.

2. Enter a Name and a Passphrase for the key. Confirm the passphrase, and click OK.

The passphrase has to correspond to the company policies. If it does not, a warning message
is displayed.

The key is created and will be used for encryption from now on.
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6.6.1.2 Encrypt files on removable media
1. In SafeGuard Portable Explorer, select the file and, using the context menu, select Encrypt.

The file is encrypted with the key last used by SafeGuard Portable.

When saving new files on removable media using a drag-and-drop procedure in SafeGuard
Portable Explorer, you are asked if you want to encrypt the files.

If this is the case, and there has been no encryption using SafeGuard Portable before, a dialog
for setting the key opens. Enter the name of the key and the passphrase (and confirm the
passphrase) in this dialog. Click OK.

2. Select the file to be encrypted with the key you have just set, and select Encrypt from the
context menu or from the File menu.

The file is encrypted, and a message is displayed upon completion.

Note: The key last used and set by SafeGuard Portable is used for all subsequent encryption
processes you perform with SafeGuard Portable, unless you set a new key.

6.6.1.3 Decrypt files on removable media
1. Select the file in SafeGuard Portable Explorer, and select Decrypt from the context menu.

The dialog for entering the media passphrase or the passphrase of a local key is displayed.

2. Enter the relevant passphrase (the sender has to provide you with this passphrase), and click
OK.

The file is decrypted.

The media passphrase gives you access to all encrypted files on the removable media, regardless
of which local key was used to encrypt them. If you only have the passphrase of a local key, you
will only have access to files which are encrypted using this key.

When decrypting a file that has been encrypted using a key you have generated in SafeGuard
Portable, this file is decrypted automatically.

After decrypting files on removable media and entering the key's passphrase, you do not have
to enter it again the next time you encrypt or decrypt files that have been encrypted with the same
key.

SafeGuard Portable stores the passphrase for as long as the application is running. The last key
used by SafeGuard Portable is used for encryption.

After you decrypt the files, they are available in plaintext on the removable media. Files that have
been decrypted are encrypted again when you close SafeGuard Portable.

6.6.1.4 Encrypt new files using SafeGuard Portable
You can also copy your own files in encrypted form onto removable media using SafeGuard
Portable.

1. Drag the required files into SafeGuard Portable Explorer.

The system asks you whether you want to encrypt the relevant file.

26

SafeGuard Enterprise



2. Confirm that you want to encrypt the file.The file is encrypted with the key last used and copied
to the removable media.

6.6.1.5 Determine the encryption state of a file
1. Select the file, and select Encryption State from the context menu or from the File menu.

The encryption state is also indicated in the Key column next to the file name in SafeGuard
Portable Explorer.

6.6.2 Other operations using SafeGuard Portable

The following operations are also available:

■ Open: This menu command is only available from the SafeGuard Portable File menu.

When you open an encrypted file with this menu command, you are prompted to enter your
passphrase. Enter your passphrase, and click OK. The file is decrypted and opened.

■ Delete: Deletes the selected file.

■ Copy to: This menu command is only available in the context menu that you can open using
your right mouse button in SafeGuard Portable Explorer.

Using this command, you can copy files from removable media to another volume on your
computer.

■ Exit: This menu command is only available from the SafeGuard Portable File menu.

Exit closes SafeGuard Portable.
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7 SafeGuard File Encryption
Note: This module is not available on endpoints with Synchronized Encryption installed.

The SafeGuard Enterprise module File Encryption offers file-based encryption on local drives and
network locations. It was especially designed for work groups to securely store data on network
shares.

After a File Encryption policy of the type Location-based has been assigned to your computer,
files in the locations covered by the policy are transparently encrypted without user interaction:

■ New files in the relevant locations are encrypted automatically.

■ If you have the key for an encrypted file, you can read and modify the content.

■ If you do not have the key for an encrypted file, access is denied.

■ If you access an encrypted file on a computer where File Encryption is not installed, the
encrypted content is shown.

■ You can check the encryption state of your files with the SafeGuard Enterprise Explorer
extensions for file-based encryption, see Explorer extensions for file-based encryption (page
37).

7.1 Encrypt according to policy
After a File Encryption policy has been assigned to your computer, existing files in the locations
covered by the encryption policy are not encrypted automatically. An initial encryption has to be
performed.

We recommend that you perform this initial encryption as soon as your computer receives a File
Encryption policy although your security officer may automatically initiate this encryption task.
This is to ensure that your data is encrypted according to the policy as soon as possible after you
received a File Encryption policy.

Some applications create a new file after modifying the content of a file and delete the old one.
Only for these applications it is true that the file is encrypted after modification. All other applications
leave the file unencrypted if it was unencrypted before modification.

To start the encryption process manually, right-click the This PC node in Windows Explorer and
select SafeGuard File Encryption > Encrypt according to policy.The SafeGuard File Encryption
Wizard (page 28) encrypts all files in folders and subfolders covered by the defined encryption
rules.

7.2 SafeGuard File Encryption Wizard
To open the SafeGuard File Encryption Wizard, right-click the This PC node or a folder in Windows
Explorer and select SafeGuard File Encryption > Encrypt according to policy.

It checks all folders that are defined in an encryption rule for the user:

■ Plain files that should be encrypted will be encrypted with the key defined in the rule.
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■ Encrypted files that should be encrypted with a different key will be re-encrypted with the key
defined in the rule.

■ An error is shown when the user does not own the current key.

■ Encrypted files that should be plaintext according to the encryption policy that applies remain
encrypted.

A status image indicates overall state of the operation:

■ Green: the operation has been finished successfully.

■ Red: the operation has been finished with errors.

■ Yellow:  the operation is in progress.

Four tab pages provide detailed information on the processed files:

■ The Summary tab page shows counters about the found/encrypted/re-encrypted/ ... files.The
Export... button can be used to create XML reports containing the processed files and the
results.

■ The Errors tab page shows files that could not be handled as required.

■ The Modified tab page shows files that have been modified successfully.

■ The All tab page shows all processed files and their results.

Clicking the Stop button in the upper right corner cancels the operation.The Stop button changes
to Restart to restart the operation.

When the operation is finished with errors, the Stop button changes to a Retry button. Clicking
the Retry button starts the operation again but only for files that failed.

7.3 Persistent encryption
When you open files encrypted by File Encryption, they are decrypted on-the-fly if you own the
necessary key. When you save the file in a location that is not covered by an encryption rule, the
Persistent encryption setting ensures that the file remains encrypted. Security officers can
disable this behavior. If Persistent encryption is disabled, files are created in plaintext when
they are copied/moved to a location not covered by an encryption rule.

Note:  Persistent encryption may not work as expected because some encryption rules override
the persistent encryption rules. In this case, please contact your security officer.
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8 SafeGuard Cloud Storage
Note: This module is not available on endpoints with Synchronized Encryption installed.

The SafeGuard Enterprise module Cloud Storage offers file-based encryption of data stored in
the cloud. It does not change the way you work with your files, but it makes sure that the local
copies of your cloud data are encrypted transparently and remain encrypted when stored in the
cloud.

Note:  Do not add files to your Dropbox folder by dropping them onto the Dropbox icon on the
Windows desktop. These files will be copied to your Dropbox folder in plaintext. To encrypt files
transparently copy them directly to your Dropbox folder.

Important: When extracting a ZIP archive using the built-in archiver of Microsoft Windows the
process stops as soon as an encrypted file is encountered for which the key is not available. The
user receives a message that access was denied, but is not informed that there are files that have
not been processed and hence are missing. Other archivers, for example 7-Zip, work fine with
ZIP archives containing encrypted files.

8.1 Cloud Storage auto-detection
SafeGuard Cloud Storage automatically detects your cloud storage provider, if supported. It will
automatically set the encryption policy to the folder to be synchronized.

8.2 Cloud Storage initial encryption
SafeGuard Cloud Storage does not perform an initial encryption of your data. Files which have
been stored before SafeGuard Cloud Storage was installed or activated by a policy remain
plaintext. If you want to encrypt these files, you have to remove them from the cloud first and then
add them again.

8.3 Set default keys
SafeGuard Cloud Storage allows you to set default keys for encrypting data in your cloud storage.
Using default keys allows you to encrypt different subfolders of your cloud storage using different
keys by setting a separate default key for each folder.You set default keys using the SafeGuard
File Encryption > Set default key ... command from the SafeGuard Explorer Extensions, see
Define a default key (page 38).

Note: To do so, your security officer has to explicitly allow the use of default keys for Cloud
Storage. If allowed, you can select a default key from a predefined set of keys and use it for
encrypting folders of your cloud storage.

Note:  If you intend to read encrypted files on Android and iOS devices with Sophos Secure
Workspace, you must use local keys for encryption. For further information, see the Sophos
Secure Workspace user help.
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Imagine you want to use Dropbox to provide secured data for different partners. Each partner
should have access to one subfolder of your dropbox. To do so, you only have to set a separate
default key for each of the subfolders. SafeGuard Enterprise will then automatically add a copy
of SafeGuard Portable, which gives partners without SafeGuard Cloud Storage access to encrypted
data, to each subfolder.You provide your partners with the respective passphrases for the keys.
Using SafeGuard Portable and the passphrase, they can decrypt data in the folder you created
for them, but they do not have access to data stored in other subfolders, because it is encrypted
with a different key.

8.4 SafeGuard Portable for Cloud Storage
You may want to access your cloud storage from home or exchange encrypted data in the cloud
by using a shared folder in your cloud storage. SafeGuard Portable allows access to encrypted
data stored in the cloud without having SafeGuard Cloud Storage installed.

Data encrypted with SafeGuard Cloud Storage can be encrypted and decrypted using SafeGuard
Portable. This is achieved by automatically copying a program (SGPortable.exe) to your
synchronization folder.

The passphrase of a local key only allows access to files that have been encrypted using this
specific key.You or any recipient can decrypt encrypted data and encrypt it again.

Note: The passphrase of a local key has to be communicated to the recipient beforehand.

The recipient can use existing keys or create a new key with SafeGuard Portable (for example,
for new files).

SafeGuard Portable does not have to be installed on or copied to your communication partner’s
computer. It remains in the cloud storage.

For a detailed description of how to use SafeGuard Portable, see Editing files using SafeGuard
Portable (page 24).

Note:  Double-clicking a file or selecting the open command will not cause in-place decryption of
the file since decrypted files in cloud storage synchronization folders would automatically be
synchronized to the cloud. When doing so a dialog appears asking you to choose a safe location
for the file. Decrypted files are not wiped automatically when SafeGuard Portable is closed.
Changes in files decrypted using SafeGuard Portable for Cloud Storage will not be done in the
encrypted original.

Note:  Do not store cloud storage synchronization folders on removable media or the network. If
you do, SafeGuard Portable creates decrypted files in those folders. SafeGuard Portable should
not be used in such cases. Consider moving the synchronization folders to fixed disks instead.
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9 Accessing SafeGuard Enterprise
You can easily access all of the important SafeGuard Enterprise endpoint functions on your
computer using the SafeGuard Enterprise system tray icon on the Windows taskbar. Right-click
the icon to display a menu with the following entries:

Note: The availability of specific menu entries depends on whether you have the relevant modules
installed and/or certain functions have been activated for you by a policy.

■ Display:

■ Key ring: Displays all keys available to you.

Note:  If your endpoint computer has been migrated from an unmanaged to a managed
environment, a second logon to SafeGuard Enterprise may be necessary to display your
user-defined local keys in your key ring.

■ User Certificate: Displays information concerning your certificate.

■ Company Certificate: Shows information concerning your company certificate.

■ Reset BitLocker credentials: Opens a dialog for changing your BitLocker PIN.

■ Create new key: Opens a dialog for creating a new key that is used for SafeGuard Data
Exchange (page 16) or SafeGuard Cloud Storage (page 30). Only available, if either module
is installed on your computer.

■ Key backup (unmanaged Windows 7 endpoints): Lets you create a backup of the key file.
This key file is necessary for logon recovery with Challenge/Response.

■ Local Self Help (Windows 7 endpoints): Starts the Local Self Help Wizard. Local Self Help is
a logon recovery method that does not require any helpdesk assistance. For further information,
see Recovery with Local Self Help (page 48).

■ Change Media Passphrase: Opens a dialog for changing the media passphrase, see
SafeGuard Data Exchange (page 16).

■ Synchronize: Starts data synchronization with the SafeGuard Enterprise Server. Tool tips
show the progress of the synchronization.

Note: You can also start synchronization by double-clicking the system tray icon.

■ Status: Opens a dialog showing information on the current status of the SafeGuard Enterprise
protected computer:

InformationField

Date and time when the computer last received a new
policy.

Last policy received
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InformationField

Date and time when the computer last received a new
key.

Last key received

Date and time when the computer last received a new
certificate.

Last certificate received

Date and time of the last server contact.Last server contact

Status of the user who is logged on to the computer
(Windows logon):

SGN user state

pending

The replication of the user in the SafeGuard POA
is pending. This means, the initial user
synchronization has not yet been completed. This
information is especially important after your first
logon to SafeGuard Enterprise as you can only log
on at the SafeGuard Power-on Authentication after
initial user synchronization has been completed.

SGN user

The user logged on to Windows is a SafeGuard
Enterprise user. An SGN user is allowed to log on
at the SafeGuard Power-on Authentication, is added
to the UMA (User Machine Assignment), and is
provided with a user certificate and a key ring to
access encrypted data.

SGN user (owner)

Provided that the default settings have not been
changed, an owner has the right to enable other
users to log on to the endpoint and become SGN
users.

SGN guest

SGN guest users are not added to the UMA, are
not provided with rights to log on to the SafeGuard
POA, are not assigned a certificate or a key ring
and are not saved to the database.

SGN guest (service account)

The user logged on to Windows is a SafeGuard
Enterprise guest user who has logged on using a
service account for administrative tasks.

SGN Windows user

A SafeGuard Enterprise Windows user is not added
to the SafeGuard POA, but has a key ring for
accessing encrypted files, just as a SafeGuard
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InformationField

Enterprise user does. The users are added to the
UMA. This means that they are allowed to log on
to Windows on that endpoint.

unconfirmed user

Unconfirmed users have no access to the keyring
due to one of the following reasons:

User provided wrong credentials.

User is a local user.

AD authentication server is not reachable.

Authentication failed.

See also Sophos knowledgebase article 124328.

The user must be confirmed by the security officer
in order to gain access to the keyring.

unknown

Indicates that the user status could not be
determined.

Indicates the safety level of the endpoint.SGN machine state

not applicable

The related feature is inactive.

machine is safe

The machine's health state is safe.

machine is compromised

The machine's health state is unsafe. Therefore,
keys have been revoked and you cannot access
encrypted files.

Indicates whether there are any packages to be sent
to the SafeGuard Enterprise Server.

Policy Cache State

Data packets prepared for transmission

Indicates whether Local Self Help has been enabled in
a policy and whether it has been activated by the user
on the computer.

Local Self Help (LSH) State

Enabled

Active

This text is displayed if the security officer has assigned
a new certificate for token logon to your computer.You

Ready for certificate change
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InformationField

can now change the certificate for token logon, see
Change the certificate for token logon  (page 66).

■ Help: Opens the SafeGuard Enterprise Online Help.

■ About SafeGuard Enterprise: Displays information about your SafeGuard Enterprise version.

9.1 Create local keys
1. Right-click the SafeGuard Enterprise system tray icon on the Windows taskbar or right-click

a volume/folder/file.

2. Click Create new key.

3. In the Create Key dialog, enter a Name and a Passphrase for the key.

The internal name of the key is displayed in the field below.

4. Confirm the passphrase.

If you enter a passphrase that is not secure, a warning message is displayed. To increase the
level of security, we recommend that you use complex passphrases.You can also decide to
use the passphrase despite the warning message. The passphrase also has to correspond
with the company policies. If it does not, a warning message is displayed.

5. If you opened the dialog using a right-click menu it contains the Use as new default key for
path option. With the Use as new default key for path option, you can set the new key
immediately as the default key for a volume or Cloud Storage synchronization folder.

The default key you specify here is used for encryption during normal operation. It will be used
until a different one is set.

6. Click OK.

The key is created and becomes available as soon as the data has been successfully
synchronized with the SafeGuard Enterprise Server.

If you define this key as the default key, all data copied to a removable storage medium or a
Cloud Storage synchronization folder from now on is encrypted using this key.

For a recipient to be able to decrypt all data contained on a removable storage medium, you may
have to re-encrypt the data on the device using the key created locally.To do so, select SafeGuard
File Encryption > Encrypt according to policy from the device's context menu in Windows
Explorer. Select the required local key and encrypt the data. This is not necessary if you use a
media passphrase.
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9.2 Overlay icons
Overlay icons are small icons displayed on elements in Windows Explorer. Their purpose is to
give you quick information on the encryption state of files. The appearance of the icons depends
on the module you have installed.

If you are using Synchronized Encryption, encrypted files are marked with a green lock symbol.
Unencrypted files have no icon.

The Data Exchange overlay icons are only displayed on files and volumes.

■ The red key indicates that you do not have a key to decrypt a file. This icon is only displayed
on files.

■ The green key is displayed if a file is encrypted and its key is in your key ring. This icon is only
displayed on files.

■ The grey key is displayed if a file is not encrypted, but an encryption rule for that file is available.
This icon is only displayed on files.

■ The yellow key is displayed if a drive has an encryption policy defined for it. This icon is only
displayed on drives.

Overlay icons will only be displayed on non-boot volumes, removable media and CDs/DVDs. On
boot drives overlay icons will be displayed in the burning staging folder (that's the folder where
Windows stores the files before they are burned on a CD/DVD). If you specify an unencrypted
folder, then no grey key will be displayed on unencrypted files in that folder and its subfolders.
Generally speaking, if a file has no encryption rule applied, no grey key is displayed.

Note:  If there are no overlay icons displayed, see Sophos knowledgebase article 108784.
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10 Accessing functions via Explorer
extensions
You can access encryption-related functions from the corresponding entries in Windows Explorer
context menus. The functions displayed depend on the settings defined in the policies. They also
depend on whether the relevant function is available for the Explorer node selected. The function
scope varies depending on whether file-based or volume-based encryption was used for the
relevant volume/folder/file.

Note:  For information on explorer extensions for Synchronized Encryption, see Encrypt/Decrypt
files manually (page 13).

10.1 Explorer extensions for file-based encryption
You can access the functions for file-based encryption (Data Exchange, File Encryption, Cloud
Storage) from the corresponding entries in Windows Explorer context menus. The functions
displayed in the menus depend on which components are installed.

The entry SafeGuard File Encryption is added to the context menu.You can access the individual
functions from this menu.

If a file-based encryption policy applies to the selected volume, removable media, folder, or file,
encryption-related entries are added to the context menu.

The following functions are available:

■ Encrypt according to policy: If you select this option, all files in folders and subfolders covered
by encryption rules are encrypted according to the policy valid for your computer.

■ Encrypt selected file: Encrypts the selected files.

■ Show encryption state: Indicates whether a volume, removable media, or a file has been
encrypted, which key has been used, whether the key is included in your key ring, and whether
you have access to this file.

■ Decrypt selected file: Decrypts the selected files.

Note:  It is not possible to decrypt files which are covered by a File Encryption rule.

■ Default key: Shows the key currently used for new files added to the volume (by saving,
copying or moving).You can define the standard key for each individual volume or removable
media separately.

■ Set default key: Opens a dialog for selecting a different default key.

■ Create new key: Opens a dialog for creating user-defined local keys.

■ Re-activate encryption:Your security officer can allow you to decide whether files on
removable media connected to your computer are to be encrypted. When you connect
removable media to your computer, a message box is displayed asking you whether you want
to encrypt the files on the attached media. In addition, your security officer can allow you to
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select whether your choice is to be remembered for the relevant media. If you select Remember
setting and do not show this dialog again, the message box will not be displayed again for
the relevant media. In this case, the new command Re-activate encryption becomes available
in the context menu of the relevant device in Windows Explorer. Select this command to revert
your decision about encryption for the relevant device. If this is not possible, for example
because you do not have the relevant rights for the device, an error message is displayed.
After you have reverted your decision, you are prompted to decide about encryption for the
relevant device again.

10.1.1 Define a default key

By defining a default key you specify the key to be used for encryption during normal operation
of SafeGuard Data Exchange and SafeGuard Cloud Storage.

You can define the default key from the context menu

■ of a file on removable media

■ of removable media

■ of a Cloud Storage synchronization folder or sub-folder

■ of a file in a Cloud Storage synchronization folder or sub-folder

■ additionally, you can set a key as default immediately when you create a new local key in the
Create key dialog.

To define a default key:

Select SafeGuard File Encryption > Set default key to open a dialog for key selection.

The key you select in this dialog is used for all subsequent encryption processes on the removable
storage medium or in your Cloud Storage synchronization folder. If you want to use a different
one, you can define a new default key at any time.

Note:  If a local key is selected for encryption of Cloud Storage, SafeGuard Portable will be copied
to the Cloud Storage synchronization folder.

By policy, a default key to be used for encryption can be specified. If it is not defined by policy
and you are allowed to set default keys, you are prompted to specify an initial default key.

10.1.2 Import keys from a file

If you have received removable media containing encrypted data or want to access Cloud Storage
data in a shared folder which has been encrypted using user-defined local keys, you can import
the key required for decryption to your private key ring.

To import the key, you need the relevant passphrase. The person who encrypted the data has to
provide you with the passphrase.

1. Select the relevant file on the removable media and click SafeGuard File Encryption > Import
key from file.

2. Enter the passphrase in the dialog that is displayed.

The key is imported, and you can access the file.
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10.2 Explorer extensions for volume-based encryption
The entry Encryption is added to the Windows Explorer context menu.

If the volume is encrypted, a key symbol is displayed next to the menu entry. If a green key symbol
is shown, you have the required keys and you can access the volume.

Note: SafeGuard File Encryption > Show encryption state shows the encryption status of the
files on the volume from a file-based encryption point of view. Files on an encrypted volume can
also be encrypted in a file-based manner. If this is the case, a dialog will be displayed accordingly.

Add/Remove Keys

You can add/remove keys to/from the encrypted volume if the settings specified in the applicable
policies allow it. By doing so, you enable all owners of the relevant key to access the encrypted
data on this volume.

You can assign keys to the volume in the volume's Properties dialog. This dialog includes the
Encryption tab (right-click on Volume > Properties > Encryption).

Select a key from the lower list, and click Add Key. The file is moved upwards from the key
selection list. It is included in the list of keys that can be used to access the encrypted volume.

With Remove Key, you can remove the key from the list of keys used for accessing the media.
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11 Recovery
For recovery (for example, if you have forgotten your password), SafeGuard Enterprise offers
various options that are tailored to different recovery scenarios. Depending on your system setup,
the following methods are available:

■ Recover encrypted files (page 40)

■ Challenge/Response for SafeGuard POA users (page 40)

■ Challenge/Response for BitLocker users (page 46)

■ BitLocker recovery key (page 47)

■ Recovery with Local Self Help (page 48)

11.1 Recover encrypted files
If a file is encrypted with a key that is not available in your keyring, you cannot open the file. This
might be the case because you are not supposed to access this file according to company policy.
However, in some cases, you may be allowed access to the file but you just happen not to have
the required key. In this case, you need to find out which key was used and ask your security
officer to assign the key to your keyring. Proceed as follows:

1. Right-click the file and then click SafeGuard File Encryption > Show encryption state.

The key used for encrypting this file is displayed.

2. Contact your security officer and provide them with the key name.

3. Ask your security officer to assign the key to your keyring.

4. As soon as your security officer confirms that your user policy has been updated, right-click
the Sophos SafeGuard system tray icon in the taskbar of your computer.

5. Click Synchronize.

6. Again, right-click the system tray icon and then click Status.

A dialog displays the date when the last key was transferred to your computer. The current
date is displayed under Last key received when your requested key has been added to your
keyring.

You can now access the file.

11.2 Challenge/Response for SafeGuard POA users
For recovery, SafeGuard Enterprise offers a Challenge/Response procedure that allows
information to be exchanged confidentially.

During the Challenge/Response procedure, you generate a challenge code (an ASCII character
string), and provide this code to a helpdesk officer. Based on the challenge code provided, the
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helpdesk officer generates a response code that authorizes you to perform a specific action on
your computer.

Recovery with Challenge/Response is available for the following logon methods in the SafeGuard
Power-on Authentication:

■ Logon with user ID and password

■ Logon with fingerprint

■ Logon with non-cryptographic token

11.2.1 Typical scenarios for which you may require help desk assistance
■ You have forgotten your password.

■ You have entered your password incorrectly too often at the SafeGuard POA. The computer
has been locked.

■ You have forgotten or lost your token/smartcard.

■ The SafeGuard Power-on Authentication's local cache is partly damaged.

■ A different user has to start the SafeGuard Enterprise protected computer.

11.2.2 Procedures for which a response can be requested and the relevant
scenarios
■ Booting the SafeGuard Enterprise endpoint without user logon:

Booting the computer without user logon helps if you have entered your password incorrectly
(for example due to typing errors, activated CAPS LOCK key, etc.), but you know the correct
password.The Challenge/Response procedure logs you on to your computer without resetting
the password.

If you have entered the password incorrectly too often, the helpdesk automatically generates
a response code for booting the endpoint without user logon. The requirement for this specific
case is included in the challenge. Afterwards, you can log on with your user name and password
again.

■ Booting the SafeGuard Enterprise endpoint with user logon:

If you have forgotten your password, do not try to enter a password, but request a challenge
right away.The help desk can then generate a response for logon with or without a user name.
When you log on with your user name, ask your help desk to have your old password displayed
during the Challenge/Response procedure. This avoids the need to reset the password.
Otherwise, when you log on with your user name, you have to reset your password for the
Windows logon during the Challenge/Response procedure.

Note:  For users working offline, that is, not connected to the domain controller, special aspects
need to be considered, see Challenge/Response for offline users (page 45).

■ Restoring the SafeGuard Enterprise policy cache:
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This procedure is necessary if the SafeGuard policy cache is damaged.The local cache stores
all keys, policies, user certificates and audit files. By default, logon recovery is deactivated
when the local cache is corrupted, that is it will be restored automatically from its backup. In
this case, no Challenge/Response procedure is required for repairing the local cache. But
logon recovery can be activated by policy if the local cache is to be repaired explicitly with a
Challenge/Response procedure. In this case, you are prompted automatically to initiate a
Challenge/Response procedure if the local cache is corrupted.

11.2.3 The Challenge/Response procedure

1. SafeGuard Power-on Authentication starts.

Note: When you generate the challenge, a time period of 30 minutes is available for entering
the response generated by the helpdesk in a Challenge/Response procedure. After 30 minutes,
the response code is no longer valid and can no longer be used.

2. Request a challenge:

Open the Challenge dialog in the SafeGuard Power-on Authentication. A challenge code in
the form of an ASCII character string is generated and displayed.

3. Contact the helpdesk.

Tell the helpdesk your user data (user ID, computer ID, etc.) as shown in the Challenge dialog,
along with the challenge code.

4. The helpdesk generates a response code in the SafeGuard Management Center.

5. The helpdesk provides the response by phone or SMS.

6. Enter the response code at the SafeGuard Power-on Authentication.

You can now perform the authorized action. For example, resetting the password.

You can resume working.

11.2.4 Request a challenge

1. In the SafeGuard Power-on Authentication (POA) logon dialog, click Recovery.

The Recovery button is only activated when you enter a user name or at least one character
in the PIN dialog.

Note:  If you have entered your password/PIN incorrectly too often or if the policy cache is
damaged, SafeGuard Enterprise informs you automatically, and offers to solve the problem
with Challenge/Response.

Your user data and a randomly generated challenge code are displayed. For better readability,
the challenge code is divided into five-character blocks.

2. Call the SafeGuard Enterprise helpdesk, and provide your user data as well as the challenge
code to the help desk officer.

If you need help stating the challenge code, you can click the Spelling Aid button.

The helpdesk officer can identify the relevant scenario from the challenge code.
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3. Click Next.

11.2.5 Enter the response

1. Enter the response code received from the helpdesk officer in the Response dialog, and click
OK.

If you enter the response code incorrectly, the character block containing the error will be
marked in red.

2. You are logged on at the SafeGuard Power-on Authentication.

If necessary, SafeGuard Enterprise will prompt you to change your Windows user credentials.

11.2.6 Best practice

11.2.6.1 You have entered the password incorrectly too often
You have entered your password incorrectly in the SafeGuard Power-on Authentication too often
(typing errors, activated Caps Lock key etc.), but you know the correct password.You are
connected to the domain.

1. Your computer is locked.You are prompted to initiate a Challenge/Response procedure to
unlock your computer.

2. The helpdesk officer generates a response for booting without user logon.

Booting without user logon means that you do not have to change your password before you
log on to Windows.

3. The Windows logon dialog is displayed. Enter your Windows password in this dialog.

You are logged on to the system.

4. The counter of the maximum number of password entry attempts allowed is reset.

Note: You can also request a response with user logon. In this case you are prompted to
change your Windows credentials before logging on to Windows.

11.2.6.2 You have forgotten your password
We recommend that you use the following methods to recover a forgotten password. By using
these methods, you avoid having your password reset centrally:

■ Use Local Self Help. With recovery by Local Self Help you can have the current password
displayed and may continue using this password without having to reset it and without any
helpdesk assistance.

■ When using Challenge/Response: Ask your helpdesk to generate a response with user logon
and to have your old password displayed during the Challenge/Response procedure. This will
avoid having to reset it.You may continue working with the old password and change it locally
afterwards, if desired.
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If you do not use one of these methods, proceed as follows:

1. If you have forgotten your password, you receive a response for booting your computer with
user logon. In this case, you have to change your password when you log on to Windows
(provided that the domain is accessible).

2. After you have changed your password, use the new password to log on at the SafeGuard
Power-on Authentication.

11.2.6.3 You have forgotten or lost your token
In this case, the Challenge/Response procedure with user logon is required.

1. You are prompted to change your password during the Challenge/Response procedure.

Note: The dialog for changing the password is only displayed if a connection to the domain
controller is established.

2. If logon with a token and PIN is mandatory, you can decide whether you want to change the
password or skip the password change by clicking Cancel.

■ You have forgotten your token

Skipping the password change by clicking Cancel in the dialog only makes sense if you
have forgotten your token but will have it for future logons. When you click Cancel, you
are logged on to the system and you can resume working with your computer.

Without a token, you can only log on with Challenge/Response in the SafeGuard Power-on
Authentication. Once you have your token again, you can use it to log on at the SafeGuard
POA.

■ You have lost your token

If you have lost your token, enter a new password in the dialog for changing your password.
You are logged on to Windows with this password. If the policies on your computer allow
it (token logon at the SafeGuard POA is not mandatory), you can also log on at the
SafeGuard Power-on Authentication using this password.

Unauthorized use of the token by anyone finding it can be ruled out. Unauthorized users
cannot use the token for logon even if they know the PIN - as your password has been
changed.

11.2.6.4 You have forgotten your PIN
1. If you have forgotten your token PIN, request a response and enter a new password.You are

logged on to Windows with this password.You can also use it to log on at the SafeGuard
Power-on Authentication, provided that you are authorized for logging on by using a password.

2. A security officer has to assign a new PIN to the token, and store your new credentials on it.
You can then use it for logging on.

11.2.6.5 You cannot access your computer any more
If you cannot access your computer any more, the SafeGuard Power-on Authentication might be
corrupted. Even in this critical situation, SafeGuard Enterprise offers a Challenge/Response
procedure with helpdesk assistance enabling you to regain access to your encrypted drives.
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Challenge/Response in this case is carried out through a WinPE environment.When encountering
such a critical situation, we recommend that you contact your SafeGuard Enterprise helpdesk.
The helpdesk officer will provide you with the necessary files and guide you through the necessary
steps to regain access to your computer.

11.2.7 Challenge/Response for offline users

Special aspects need to be considered for Challenge/Response procedure for offline users. For
offline users (that is, users who are not connected to the domain controller, for example sales
representatives working with their notebooks), an automatic password change cannot be initiated
during the Challenge/Response procedure.

11.2.7.1 Challenge/Response for offline users with logon mode user name/password
Example:

You are working offline (you are not connected to the domain controller), and you have forgotten
your password.With the Challenge/Response procedure, you can quickly and easily regain access
to your computer.

SafeGuard Enterprise can also log you on to Windows automatically during the
Challenge/Response procedure. However, as you would not know the password after this
procedure, you would have to repeat it each time you start your computer. Furthermore, you would
not be able to unlock your computer in case it was locked (for example, a lock on screen saver
activation). In this case, you would have to restart your computer risking data loss (and initiate a
Challenge/Response procedure again).

Note:  For this reason, SafeGuard Enterprise offers the possibility to show the password during
a Challenge/Response procedure. As an offline user you should have your password displayed
during a Challenge/Response procedure. Tell the helpdesk officer that you would like to have
your password displayed. The helpdesk officer has to activate password display explicitly before
generating your response code.

Proceed as follows:

1. To initiate the Challenge/Response procedure, click Recovery in the SafeGuard POA logon
dialog.

2. Call your helpdesk and tell them your challenge code.

3. Tell the helpdesk officer that you would like to boot your computer with user logon and that
your password is to be displayed.

4. In the Challenge/Response dialog, click Next and enter the response.

5. Click OK.

You are asked whether your old password is to be displayed on screen

6. Answer Yes, and click OK.

7. The next dialog informs you that your password will be displayed when you press Enter or
the Spacebar on your keyboard, or when you click in the text.

Note:  Do not click OK. If you click OK, the boot process will continue WITHOUT showing the
password.

The password is shown for 5 seconds. The boot process then continues automatically.
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8. Press Enter or the Spacebar on your keyboard, or click in the text.

The password is displayed.

Note:  Make sure that no unauthorized person can view the contents of your screen, by chance
or on purpose.You can immediately hide your password by pressing the Spacebar, Enter,
or by clicking the blue display.The password will only be shown for 5 seconds at the maximum.

9. You can read the password, and use it for logging on at the SafeGuard Power-on Authentication
and to Windows.

You can resume working with your computer.

11.2.7.2 Challenge/Response for offline users with logon mode "Only Token"
In this case, if you have forgotten your PIN or forgotten/lost your token, the procedure to be used
depends on whether you know your Windows credentials.

■ You know your Windows credentials

a) If you know your Windows credentials, initiate the Challenge/Response procedure as
described.You are automatically logged on to Windows.

Logon mode Only Token is reset for the duration of the work session following the
Challenge/Response procedure. Consequently, logging on to Windows with your user name
and password is also possible.

In case your computer should be locked, you can therefore unlock it by entering your
Windows password. But logging on at the SafeGuard Power-on Authentication is only
possible with Challenge/Response.

■ You do not know your Windows credentials

a) If you do not know your Windows credentials and you have forgotten your PIN, you can
also start a Challenge/Response procedure during which your password will be displayed.

b) Tell your helpdesk officer that your password should be displayed.

As logon mode Only Token will be deactivated you can also unlock your computer - should
it be locked - with this password. But logging on at the SafeGuard Power-on Authentication,
however, is only possible with Challenge/Response.

11.3 Challenge/Response for BitLocker users

General hints on using mouse and/or keyboard
■ You can select controls by using the mouse and/or the keyboard. To jump from one control

to the next with the keyboard press the Tab key. To get back into the previous control use
Shift+Tab.

■ Confirm selections by pressing Enter.
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Challenge/Response procedure

If you need to get a BitLocker recovery key, proceed as follows:

1. Reboot the PC. After rebooting, a yellow message appears. Press any key within the next
three seconds.

2. The Sophos Challenge/Response screen appears.
3. In Step 2 information required to call the helpdesk is provided to you.
4. Provide the following information to the helpdesk:

■ Computer, for example Sophos\<Computer name>

■ Challenge code, for example ABC12-3DEF4-56GHO-892UT-Z654K-LM321. Move your
mouse over the characters to display a spelling aid or press F1 several times to display
this help box. The code expires after 30 minutes leading to an automatic shutdown of the
PC.

5. Enter the response code from the helpdesk (six blocks with two text fields each and five
characters required per field).

■ As soon as a text field is completely populated, the focus is automatically switched to the
next text field.

■ If you accidentally enter a wrong character in a block, the corresponding block will be
highlighted in red.

6. After you have successfully entered the response code, click Continue or press Enter to
complete the Challenge/Response action.

Reset BitLocker credentials

As soon as you are logged on to the system again, specify new BitLocker credentials so that you
will not need another Challenge/Response procedure for your next logon. Depending on your
operating system and BIOS/UEFI version the system will display a dialog for the credential reset.

If this dialog does not appear automatically, right-click the SafeGuard Enterprise icon in the
taskbar. A context menu opens. Select Reset BitLocker credentials and follow the on-screen
instructions.

Note:

If you want to shut down or restart the system, click the shut down button or press the Tab key
until the shut down button is highlighted:

11.4 BitLocker recovery key
As a BitLocker user on a system that does not support SafeGuard Challenge/Response, you can
request a BitLocker recovery key from your helpdesk.
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General hints on using mouse and/or keyboard
■ You can select controls by using the mouse and/or the keyboard. To jump from one control

to the next with the keyboard press the Tab key. To get back into the previous control use
Shift+Tab.

■ Confirm selections by pressing Enter.

Request the recovery key

If you need to get a BitLocker recovery key from your helpdesk, proceed as follows:

1. Reboot the endpoint. After rebooting, press the Esc key in the BitLocker logon screen.
2. The screen for entering a BitLocker recovery key appears.
3. In Step 2 information required to call the helpdesk is provided to you.

For example: <Computer name> C: 9/25/2014

4. Provide the Computer name to the helpdesk.
5. Then enter the BitLocker recovery key from the helpdesk (eight blocks with six characters

required per field).
6. After you have successfully entered the response code, click Continue or press Enter to

complete the recovery action.

Reset BitLocker credentials

As soon as you are logged on to the system again, specify new BitLocker credentials so that you
will not need another Challenge/Response procedure for your next logon. Depending on your
operating system and BIOS/UEFI version the system will display a dialog for the credential reset.

If this dialog does not appear automatically, right-click the SafeGuard Enterprise icon in the
taskbar. A context menu opens. Select Reset BitLocker credentials and follow the on-screen
instructions.

Note:

If you want to shut down or restart the system, click the shut down button or press the Tab key
until the shut down button is highlighted:

11.5 Recovery with Local Self Help
Note:  Local Self Help is only available for Windows 7 endpoints with SafeGuard Power-on
Authentication (POA).

If you have forgotten your password, Local Self Help enables you to log on to your computer
without the assistance of a helpdesk.

Using Local Self Help, you can regain access in situations where neither telephone nor network
connections are available, and you therefore cannot use a Challenge/Response procedure (for
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example, aboard an aircraft).You can log on to your computer by answering a specified number
of predefined questions in the SafeGuard Power-on Authentication.

The security officer can define the questions to be answered and distribute them to the endpoints.
You can also define your own questions, if the relevant policy entitles you to do so. The Local
Self Help Wizard helps you provide the initial answers and edit the questions.You can open the
Local Self Help Wizard by clicking the SafeGuard Enterprise system tray icon on the Windows
taskbar.

Prerequisites

To use Local Self Help for logon recovery, the following prerequisites must be met:

■ The security officer has enabled Local Self Help in the relevant policy and has defined the
settings for this function (for example, the right to define your own questions).

■ You have activated Local Self Help on your computer.

11.5.1 Activate Local Self Help

After the policy entitling you to use Local Self Help has become effective, you have to activate
the function by answering the predefined questions received or by defining and answering your
own questions.

Local Self Help only becomes active on your computer after you have answered and saved a
predefined number of questions. The security officer specifies how many questions you have to
answer.The Local Self Help Wizard guides you through the process and shows how many answers
are required. Depending on the policy settings, these are the possible scenarios:

■ You have received predefined questions, and you are NOT entitled to define your own
questions.

Answer and save the predefined questions received. The Local Self Help Wizard shows how
many answers are required.

■ You have received predefined questions, and you are entitled to define your own
questions.

Answer and save the required number of questions (predefined questions, your own defined
questions, or a combination of both).

■ You have NOT received predefined questions, and you are entitled to define your own
questions.

Define, answer, and save the required number of questions.

Note: To log on at the SafeGuard Power-on Authentication with Local Self Help, you have to
answer questions randomly selected from the questions answered in the Local Self Help Wizard.
The security officer specifies how many questions you have to answer in the SafeGuard POA.

Prerequisite: After receiving the policy, the tool tip indicates that there are unanswered Local
Self Help questions. Restart your computer to add the Local Self Help command to the context
menu of the system tray icon on the Windows taskbar.
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To activate Local Self Help:

1. Right-click the SafeGuard Enterprise system tray icon on the Windows taskbar.

2. Select Local Self Help.

The Local Self Help Wizard Welcome dialog is displayed.

For security reasons, you are prompted to enter your password.

3. Enter your password, and click Next.

The Status Overview dialog is displayed.

This dialog tells you how to activate Local Self Help. It also displays status information (for
example the number of answered user-defined questions or the number of answered predefined
questions).

4. Click Next.

If you have received predefined questions with the effective policy, the Predefined questions
dialog is displayed.

■ If you have received several different question themes, you can choose from the question
themes displayed in the drop-down list of the Theme field.

■ To answer the questions, click on the relevant question, and enter your answer in the
Answers column.

■ After you enter the answer, the text entered is hidden. To view the text, select Show
answers.

Note: When answering the questions during a recovery process in the SafeGuard Power-on
Authentication, you will need to enter the answers exactly as you entered them in the Local
Self Help Wizard. For example, answers are case-sensitive in Local Self Help.

Note:  Not all characters that can be entered in Windows can be handled by the SafeGuard
POA, for example Hebrew or Arabic characters cannot be used. When entering answers in
Japanese, you have to use Romaji (Roman) characters. Otherwise the answers will not match
when you answer the questions in the SafeGuard POA.

5. After you have finished answering the predefined questions, click Next.

6. If you are entitled to define your own questions, the User defined questions and answers
dialog is displayed.

a) To add a new question, click New Question.

A new line is added to the list of questions.

b) Enter your question in the Questions column and the answer in the Answers column.

After you enter the answer, the entered text is hidden.

c) To display the text, select Show answers.

7. After you have finished defining and answering your own questions, click Next.

The last dialog of the Local Self Help Wizard shows the new status information after you answer
the questions. A message indicates whether the prerequisites for activating Local Self Help
have been met.
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8. Click Finish.

The questions and answers are saved. A message is displayed indicating that Local Self Help
was activated successfully.

9. Click OK.

Local Self Help is active on your computer.You can use Local Self Help for logon recovery in the
SafeGuard Power-on Authentication.

11.5.2 Activate Local Self Help - reminder

It is essential that you activate Local Self Help. For this reason SafeGuard Enterprise will remind
you to enroll in Local Self Help and to set up your Local Self Help questions in three stages:

■ Stage 1

A balloon tool tip pops up every hour for one calendar day and indicates that Local Self Help
needs to be set up. On the following calendar day, stage 2 starts.

■ Stage 2

In addition to stage 1 behavior, the Local Self Help Wizard starts every time you log on to or
unlock the computer.You can postpone running the wizard. After 3 calendar days, stage 3
starts.

■ Stage 3

In addition to stage 2 behavior, but without a tool tip notification, the Local Self Help Wizard
starts every 60 minutes.

The user is immediately notified by a balloon tool tip and stage 1 is entered whenever Local Self
Help has to be reactivated due to changes in one of the following:

■ Local Self Help parameters

■ Windows password

■ certificate

11.5.3 Edit questions

After activating Local Self Help on your computer, you can edit the questions at any time:

■ For predefined questions, you can change the answers that were provided when answering
the questions initially. However, predefined questions cannot be deleted.

■ For user-defined questions, you can change the answers that were provided when answering
the questions initially, add new questions, or delete questions.

1. Right-click the SafeGuard Enterprise system tray icon on the Windows taskbar.

2. Select Local Self Help.

The Local Self Help Wizard Welcome dialog is displayed.

For security reasons, you are prompted to enter your password.
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3. Enter your password, and click Next.

The Status Overview dialog is displayed.

This dialog tells you how to activate Local Self Help. It also displays status information (for
example, the number of answered user-defined questions, the number of answered predefined
questions, etc.).

4. Click Next. If you have received and answered predefined questions, the Predefined Questions
dialog is displayed, containing the answered questions.

a) If you have received several different question themes, you can choose between the
question themes to be displayed in the drop-down list of the Theme field.

b) By default the answers entered are not shown as text. To show the text entered, select the
Show answers check box.

c) To change the answers, click the relevant questions and enter your new answer in the
Answers column.

5. Click Next. If you are entitled to define your own questions, the User defined questions and
answers dialog is displayed. By default the answers entered are not shown as text.

a) To show the text entered, select the Show answers check box.

b) To change existing answers, click the relevant question and enter your new answer in the
Answers column.

c) To add a new question, click New Question.

A new line is added to the list of questions. Enter your question in the Questions column,
and the answer in the Answers column.

d) To delete questions, click the relevant question and click Delete Question.

A message is displayed, prompting you to confirm that you want to delete the question.
Click Yes.

6. Click Next.

The last dialog of the Local Self Help Wizard shows the new status information after you edit
the questions. A message indicates whether the prerequisites required for Local Self Help to
remain active have been met.

7. Click Finish.

The questions and answers are saved. A message is displayed indicating that the editing
procedure was successful, and Local Self Help remains active.

8. Click OK.

The modifications take effect.

Next time you launch Local Self Help in the SafeGuard Power-on Authentication, the modified/new
questions are selected randomly and displayed. The modified/new answers apply.

Note:  If the number of answered questions falls below the minimum number required due to the
changes made, a warning message is displayed in the last dialog of the Local Self Help Wizard,
indicating that Local Self Help will be deactivated after you close the wizard. If you do not want
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to deactivate Local Self Help, you can return to User defined questions and Predefined
questions by clicking the Back button.You can then add or answer new questions. If you click
Finish and the number of answered questions has fallen below the minimum number required,
another warning message is displayed, indicating that Local Self Help is no longer active on your
computer. However, in this case, you can reactivate Local Self Help.

11.5.4 Changes of question parameters

The security officer can define the following parameters that apply to Local Self Help questions:

■ The number of questions you have to answer in the Local Self Help Wizard to activate Local
Self Help on your computer.The number of questions specified must be available with answers
for Local Self Help to remain active.

■ The number of questions you have to answer in the SafeGuard POA to log on with Local Self
Help.The questions displayed in the SafeGuard POA are selected randomly from the questions
you have answered in the Local Self Help Wizard.

If these two parameters change due to a new policy deployed to your computer, the following
scenarios may occur:

User action requiredLSH actionCondition

None.Local Self Help remains active on
your computer.

The number of questions you have
to answer in the LSH Wizard
changes, but there are enough
questions available for Local Self
Help to remain active on your
computer.

To reactivate Local Self Help, open
the Local Self Help Wizard and
follow the Wizard instructions.

A message is displayed stating that
your Local Self Help settings have
changed. The questions available
on your computer are no longer

The number of questions you have
to answer in the LSH Wizard
changes and there are not enough
questions available for Local Self

valid. Local Self Help is no longer
active on your computer.

Help to remain active on your
computer.

Open the Local Self Help Wizard
and follow the Wizard instructions.

A message is displayed stating that
your Local Self Help settings have
changed. The questions available

The number of questions you have
to answer in the SafeGuard POA
to log on with Local Self Help
changes. on your computer remain valid.

The ratio between available
questions and valid answers has
changed.

11.5.5 Changes of conditions or parameters for Local Self Help during editing
processes

Local Self Help parameters and other conditions that are crucial for the usage of Local Self Help
may change while you are defining or editing questions in the Local Self Help Wizard.
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For example:

■ A new user password or certificate may be set.

■ A new policy with new Local Self Help settings and/or a new set of Local Self Help questions
may be transferred to your computer through the regular update mechanism.

If such changes occur during the editing process, the set of questions and answers you have
defined may no longer be valid and there may not be enough questions for Local Self Help to
become or stay active on your computer.

Therefore, each time you finish defining or editing questions in the Local Self Help Wizard, the
wizard checks whether any of the following conditions apply and initiates the relevant action:

ResultLSH Wizard actionCondition

Local Self Help can no
longer be used.

The Local Self Help Wizard shows a
message stating that Local Self Help has
been disabled globally and closes.

Local Self Help has been disabled
globally by a new policy.

Local Self Help is active
on your computer and

The Local Self Help Wizard shows a
message stating that the Local Self Help

Local Self Help parameters have
been changed (for example

can be used for logonparameters have changed, saves your
changes and closes.

minimum length of answers, right
to define your own questions, the
number of questions to be

recovery. But the ratio of
available questions and

answered) by a new policy. Local
Self Help has not been disabled.

The questions and answers you
have defined are still valid and

valid answers may have
changed. To regain the
initial ratio, you may need
to add or delete questions
and/or answers.

sufficient for Local Self Help to be
active on your computer.

To activate Local Self
Help, rerun the Local Self

The Local Self Help Wizard shows a
message stating that the user password orThe user password has been

changed Help Wizard and defineLocal Self Help parameters have changed.
questions and answersLocal Self Help will not be active on yourand/or
again. Afterwards, youcomputer.You are advised to rerun the

wizard. The wizard closes. can use Local Self Help
for logon recovery.

Local Self Help parameters
have been changed (for
example minimum length of
answers, right to define your
own questions, the number of
questions to be answered etc.)
by a new policy. Local Self
Help has not been disabled.

The questions and answers
you have defined are no longer
valid and there are not enough
questions for Local Self Help
to be active on your computer.
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ResultLSH Wizard actionCondition

To activate Local Self
Help, rerun the Local Self

The Local Self Help Wizard shows a
message stating the user certificate has

The user certificate has changed.

Help Wizard and definechanged. Local Self Help will not be active
questions and answerson your computer.You are advised to rerun

the wizard. The wizard closes. again. Afterwards, you
can use Local Self Help
for logon recovery.

11.5.6 Log on at the SafeGuard POA with Local Self Help

1. In the SafeGuard POA logon dialog, click the Recovery button.

■ If only Local Self Help is activated for logon recovery, Local Self Help is started.

■ If Local Self Help and Challenge/Response are available for logon recovery, a dialog with
both recovery methods for selection is displayed. Click Local Self Help.

Note:

If you usually log on to the SafeGuard Power-on Authentication with a token or smartcard, you
first have to remove the token/smartcard from your computer. After that the SafeGuard POA
logon dialog for logging on with user name and password is displayed. Enter your user ID and
click the Recovery button.

The Local Self Help Welcome dialog is displayed.

This dialog provides a short description of the next steps.

2. Click Next to start answering the questions.

The first question is displayed.

3. Enter your answer.

By default, the text entered is not displayed in the input field for security reasons. To display
the answer, clear the Hide answer check box.

4. After answering the question, click Next.

You can only click Next and continue with the next question after you have entered an answer.

5. Answer the remaining questions. After answering the last one, click OK.

In the next dialog, you can display your current password.
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6. To display the password, press Enter or Spacebar or click the blue box.

Note:

Do NOT click OK. After clicking OK the startup process will continue WITHOUT showing the
password.

The password will be shown for a maximum of five seconds. Afterwards, the startup process
continues automatically.

Note:  Make sure that no unauthorized person can view the contents of your screen, by chance
or on purpose.You can immediately hide your password by pressing the Spacebar, Enter,
or by clicking the blue display box.

7. You can read the password and use it for logging on at the SafeGuard Power-on Authentication
and to Windows again.

8. After reading the password, click OK. Otherwise, the startup process will continue automatically,
five seconds after showing the password.

You are now logged on to the SafeGuard Power-on Authentication and to Windows.

11.5.7 Failed logon attempts

If you enter a wrong answer for one or several questions, logon fails. In this case, a message
indicating the failed logon is displayed. For security reasons, Local Self Help does not indicate
which of the answers were wrong.

A failed Local Self Help recovery procedure is considered a failed logon attempt and logged as
an event. In this case, a logon delay goes into effect.The logon delay period increases with every
failed logon attempt.

If you restart your computer after a failed logon attempt, and select logon recovery with Local Self
Help again, questions are randomly selected again.

11.5.8 Reactivate questions and answers after password changes on several
machines

If you use different computers with Local Self Help activated, and you change your Windows
password on one machine, the Local Self Help questions and answers are no longer active on
the second (or any further) machine after the password change has become effective. But the
questions and answers are still available in the Local Self Help Wizard. To use the same set of
questions on the second computer again, confirm it in the Local Self Help Wizard.

1. After you have changed your password on one machine, log on to the second machine.

A tool tip indicates that there are unanswered Local Self Help questions.

2. Right-click the SafeGuard Enterprise system tray icon on the Windows taskbar and select
Local Self Help.

The Local Self Help Wizard Welcome dialog is displayed.

3. Enter your password, and click Next.

4. Confirm all following Local Self Help Wizard dialog pages with Next and click Finish on the
last one.
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The questions and answers stored previously on the computer are active again and are used
when you log on to the SafeGuard POA with Local Self Help.
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12 Troubleshooting
If you are having trouble synchronizing your endpoint with the server, you can use the Client/Server
Connectivity Check tool to find out, why the communication between the SafeGuard Client and
the SafeGuard Server fails.

To open the SafeGuard Enterprise Client/Server Connectivity Check tool, go to C:\Program
Files (x86)\Sophos\SafeGuard Enterprise\Client and run the SGNCSCC.exe
application.

For more information, see Sophos knowledgebase article 109662.
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13 SafeGuard Power-on Authentication
(Windows 7 only)
Note: The entire chapter on SafeGuard Power-on Authentication is only relevant for endpoints
with Windows 7 (BIOS) and only if SafeGuard Power-on Authentication is installed on your
computer.

SafeGuard Power-on Authentication (POA) requires you to authenticate before the computer's
operating system is started. After you do this, Windows starts and you are logged on automatically.
The procedure is the same when the computer is switched back on from hibernation (Suspend
to Disk).

SafeGuard POA look and feel

The look and feel of the SafeGuard POA can be customized according to your company's
requirements.Your security officer does this in the policy settings in the SafeGuard Management
Center.

The following adjustments are possible:

■ Logon image

The default logon image displayed in the SafeGuard POA is a SafeGuard design. This screen
is customizable by policy to show your company logo, for example.

■ Dialog text

All text in the SafeGuard POA is displayed in the default language set in the Windows Regional
and Language Options.You can change the language used in the POA by changing the default
language. The language of the dialog text can also be specified by the security officer in a
policy.

13.1 First logon after installation
Note:  SafeGuard Enterprise uses certificate-based logon. However, user-specific keys and
certificates are only created after Windows logon.

When you log on for the first time after installation, you must first log on to Windows as usual
using your credentials. Afterwards, you are registered as a SafeGuard Enterprise user. This
registration process is required to make sure that your credentials are recognized in the SafeGuard
POA the next time the system is started.

A tool tip informs you about the successful registration and receipt of all required data.

When you restart the computer, the SafeGuard Power-on Authentication (POA) is activated. From
now on, you enter your Windows credentials at the SafeGuard POA.You are then logged on to
Windows automatically without any further password entry (if automatic logon to Windows is
activated).
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You can log on at the SafeGuard POA by using your user name and password.

First logon procedure

This section describes the procedure for the first logon to your computer after SafeGuard Enterprise
has been installed.The procedure will only correspond to the one described here if the SafeGuard
POA has been installed and activated for your computer.

13.1.1 SafeGuard Autologon

1. The computer starts, and the SafeGuard Autologon dialog is displayed.

■ A SafeGuard autouser is logged on.

■ If a connection to the SafeGuard Enterprise Server exists, the computer is automatically
registered on the SafeGuard Enterprise Server.

■ The machine key is sent to the SafeGuard Enterprise Server and stored in the SafeGuard
Enterprise database.

■ Machine policies are sent to the computer.

13.1.2 Windows logon

1. The Windows logon dialog is displayed.

2. SafeGuard Enterprise offers the SafeGuard Enterprise and the Windows authentication method.
Windows provides two icons for the two methods:

■ Click Other User to open a dialog for entering credentials.
■ Click the second icon (with a user name displayed below it) to open a dialog that contains

the user information of the last user who has logged on to the system.You only have to
enter the password.

If your user name is displayed below a SafeGuard Enterprise icon, click that icon. If this is not
the case, select the SafeGuard Enterprise icon with Other User below it.

3. Enter your Windows user credentials as usual.

■ Your user ID and a hash of your credentials are sent to the server.

■ User policies, certificates, and keys are created and sent to the endpoint.

The user data will become available in the SafeGuard Power-on Authentication after all data
has been successfully synchronized between the SafeGuard Enterprise server and your
computer.

This means that the next time the system is started you only have to enter your Windows
user credentials (user name and password) in the SafeGuard POA and you are logged on
automatically.

You must restart the computer to activate SafeGuard Power-on Authentication fully. After the
restart, the SafeGuard Power-on Authentication protects your computer against unauthorized
access.
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13.1.3 SafeGuard Power-on Authentication logon after restart

1. When you restart your computer, the SafeGuard Power-on Authentication logon dialog is
displayed.

Certificates and keys are available, and you can log on at the SafeGuard POA using your
Windows user credentials.

2. Enter your user name and password, and click OK.

Your user credentials are evaluated. After the system has verified your credentials, you are
automatically logged on to Windows.

Note:  Logon pass-through to Windows may be deactivated by a policy setting. In this case,
the Windows logon dialog is displayed and you have to enter your user credentials.

13.2 Logon with SafeGuard Power-on Authentication
After successful activation of the SafeGuard Power-on Authentication (initial synchronization and
restart), you log on by entering your Windows user credentials in the SafeGuard POA logon dialog.
You are logged on to Windows automatically.

Note: You can deactivate automatic logon to Windows by clicking the Options button in the
logon dialog and clearing the  Pass through logon to Windows check box. Deactivating the
automatic logon is, for example, necessary to enable other users to use SafeGuard Power-on
Authentication on the computer, see Register further SafeGuard Enterprise users (page 62). The
security officer defines, in the relevant policies, whether logon pass-through to Windows is activated
or deactivated and whether you are allowed to change this setting in the logon dialog.

Logon delay on failed logon attempt

If logon at the SafeGuard Power-on Authentication fails, for example, due to an incorrect password,
an error message is displayed, and a delay is imposed before the next logon attempt. The delay
period is increased with each failed logon attempt. Failed attempts are logged.

Machine lock

After a set number of failed logon attempts, your computer will be locked.To unlock your computer,
initiate a Challenge/Response procedure, see Challenge/Response for SafeGuard POA users
(page 40).

13.2.1 Logon recovery

For logon recovery for example, if you have forgotten your password, SafeGuard Enterprise offers
different options that are tailored to different recovery scenarios. The recovery methods available
on your computer depend on the settings specified by the security officer. For further information,
see Recovery (page 40).
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13.3 Logon with Windows authentication
Usually, you are automatically logged on to Windows after entering your credentials at the
SafeGuard Power-on Authentication (POA). If you want to log on to Windows separately, do the
following:

Depending on the logon settings in central administration, either a dialog for entering user
credentials or a PIN entry dialog is displayed.

1. In the SafeGuard POA logon dialog, click Options and clear the Pass through logon to
Windows check box.

The Windows logon dialog is displayed. Depending on the logon settings in central
administration, either a dialog for entering user credentials or a PIN entry dialog is displayed.

2. Enter your credentials or the PIN and click OK.

Now the SafeGuard Enterprise functionality is available and you can, for example, access
encrypted data, if you have the necessary key.

13.4 Register further SafeGuard Enterprise users
To allow another Windows user to log on to your computer:

1. Switch on the computer.

The SafeGuard POA logon dialog is displayed. The second Windows user cannot log on at
the SafeGuard POA because they do not have the necessary keys and certificates.

2. For the second user to log on at the SafeGuard POA, the computer's owner must allow it.

Note: The default setting specifies that the first user to log on after installation is registered
as the owner of the computer. The security officer can also define the owner of a computer
with a policy setting.

3. In the SafeGuard POA logon dialog, click Options and clear the Pass through logon to
Windows check box. Log on with your credentials as the computer's owner.

The Windows logon dialog is displayed.

4. The second user enters their Windows credentials.

5. If the second user's certificate, and key are all available on the computer (evident from the
relevant balloon tool tip), an entry for the second user is created in the SafeGuard Enterprise.

The next time the computer is started, the second user can log on at the SafeGuard Power-on
Authentication.

Note:  Security officers can assign users to the SafeGuard POA on a new machine in the
SafeGuard Management Center. Users assigned in this way can log on at the SafeGuard Power-on
Authentication on the relevant computer.
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13.5 Temporary password in the SafeGuard POA
SafeGuard Enterprise allows you to change the password temporarily in the SafeGuard POA.
Changing the password temporarily is recommended if you suspect that somebody has watched
you enter your password.

Example:You start your notebook in a public place, for example at the airport.You think that
somebody watched you enter your password at the SafeGuard POA. Since you are not connected
to Active Directory (AD), you cannot change your Windows password.

Solution:You temporarily change your SafeGuard POA password to ensure that no unauthorized
person knows your password. As soon as you are connected to AD again, you are automatically
prompted to change the temporary password.

1. In the SafeGuard POA logon dialog, enter the existing password.

2. Press F8.

Note:  If you do not enter the existing password before you press F8, the system interprets
this as a failed logon, and an error message is displayed.

3. In the dialog, enter the new password and confirm it.

The system reminds you that the password change is only temporary.

4. Click OK.

Note:  If you cancel this dialog, you will be logged on with your old password.

The Windows logon dialog is displayed.

Note:  Logon will not be passed through to Windows, even if your system is configured that
way. Enter the "old password" here. The temporary password is only valid for logging on at
the SafeGuard POA.

5. Click OK.

You are logged on to Windows.

For logging on at the SafeGuard POA, you can now only use the temporary password. The
temporary password is valid until the password is changed at the Windows logon. Only after you
do that can logon be passed through from SafeGuard POA to Windows again.

Changing the temporary password

The password changed temporarily in the SafeGuard POA has to be changed later to synchronize
passwords again.

When you log on to Windows, SafeGuard Enterprise automatically prompts you to change your
password as soon as you are connected to Active Directory again.

You can close the dialog prompting you to change the password without actually changing the
password. In this case, the dialog is shown each time you log on until you change the password.

Note: The SafeGuard POA password can also be changed temporarily while you are connected
to Active Directory. In this case, the dialog for changing the password is shown immediately after
changing the password temporarily in the SafeGuard POA.You can close this dialog without any
changes and use the "old password" for logging on.You can change the password later.
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13.6 Logon with smartcards or tokens
There are two possible types of logon with smartcards or tokens:

■ Logon is only allowed with smartcards or tokens.

■ Logon is allowed either with user name and password or with smartcard or token.

The security officer defines the allowed logon type in a policy.

Your smartcard/token is either provided by your security officer or you equip your smartcard/token
with your Windows user credentials yourself.

Note:  SafeGuard Enterprise handles smartcards and tokens in the same way. So the terms
"token" and "smartcard" mean the same in the product and the manual. In the following sections,
the term "token" is used.

13.6.1 First logon with token after installation

The first logon with a token is identical to the logon procedure without a token.

If an issued token is available, you can use it to log on to Windows by entering the token PIN.

Note: We recommend that you configure your token with Windows user credentials before you
restart the computer, see Store Windows user credentials on your token (page 65). The security
policies that apply to you may require using a token at the SafeGuard POA. If your token does
not contain your credentials, you cannot log on at the SafeGuard Power-on Authentication.

13.6.2 SafeGuard POA logon with token

Prerequisites: Make sure that USB support is activated in the BIOS. Token support has to be
initialized, and the token has to be issued for you.

1. Plug in the token.

2. Switch on the computer.

The dialog for token logon is displayed.

Note:  If your policy allows you to log on with your user credentials and you disconnect the
token, you are prompted to enter your user credentials for logging on. If the dialog for logging
on with a user ID and password is not displayed, you can only log on at the SafeGuard Power-on
Authentication with a token.

3. Enter your token PIN.

You are logged on at the SafeGuard Power-on Authentication and to Windows (if the Pass
through to Windows check box is selected in the logon dialog).

13.6.3 Change the PIN

You can change your token PIN in the Windows logon dialog.
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If Pass through logon to Windows is selected at the SafeGuard Power-on Authentication (POA),
the Windows logon dialog is usually not displayed. To display the Windows logon dialog, you
have to clear this check box during SafeGuard POA logon.

Note: You are automatically prompted to change the PIN if the security officer has defined rules
requiring a PIN change (for example, at specific time intervals).

1. In the PIN dialog for Windows logon, select the Change PIN check box.

2. Enter your token PIN and click OK.

The PIN Change dialog is displayed.

3. Enter the new PIN and confirm it.

4. Click OK.

The token PIN is changed and Windows logon continues.

13.6.4 Store Windows user credentials on your token

If your token does not contain your Windows user credentials, you can store them on the token
yourself.

Note: We recommend that you configure your token during first logon. The security policies that
apply to you may require using a token at the SafeGuard POA. If your token does not contain any
user information, you cannot log on at the SafeGuard Power-on Authentication.

1. During the first logon after installation, connect your token with the system when the Windows
logon dialog is displayed.

If the system detects an empty token, the Issue Token dialog is displayed automatically.

2. Enter your Windows user name and password.

3. Confirm your password.

4. Select or enter the domain, and click OK.

If logon is successful, the data is stored on the token.

You are logged on to Windows.

If token logon is defined as optional for your user (that is you have already logged on once at the
SafeGuard POA with your user name and password), you can also issue the token later.

To do so, click Options in the SafeGuard POA logon dialog and clear the Pass through logon
to Windows check box.The Windows logon dialog is displayed, and you can store your credentials
on the token as described.

13.6.5 Token logon recovery

If you use a non-cryptographic token and you have forgotten your PIN, you can regain access to
your computer with one of the following recovery methods:

■ Recovery with Local Self Help (page 48).

■ Challenge/Response for SafeGuard POA users (page 40).

65

user help



The recovery methods available on your computer depend on the settings specified by the security
officer.

To initiate recovery, click the Recovery button in the token logon dialog.

Note: These recovery methods are not available for cryptographic tokens. If logon problems
occur, contact your security officer.

13.6.6 Unblock tokens

If you enter your PIN incorrectly several times, your token is blocked. The security officer can
configure SafeGuard Enterprise to display the Unblock Token dialog in this case.

The security officer has to provide you with the administrator PIN defined for your token.

1. In the Unblock Token dialog, enter the administrator PIN.

2. Enter a new PIN and confirm it.

The PIN you enter is subject to the rules defined for PINs (for example, specific character
combinations may be required, PINs already used may be banned from being used again).

3. Click OK.

The token is unblocked and logon continues.

Note:  If this function is not available on your computer, you can regain access to your computer
with Challenge/Response. But you cannot change the PIN or your user credentials with
Challenge/Response.

13.6.7 Cryptographic tokens - Kerberos

If you use a cryptographic token, you are authenticated at the SafeGuard POA by the certificate
stored on the token.

For this type of logon, you need a token issued by your security officer or any other authorized
person. To log on to the system, you only have to enter the token PIN. If this type of logon is the
only type valid for your computer, you cannot log on without the token.

Note:  If you use a token of this type, neither Challenge/Response nor Local Self Help is available.
In the event of logon problems, contact your security officer.

13.6.8 Change the certificate for token logon

To change or renew the certificate used for logging on with a token, your security officer can
assign a new certificate to your computer. After synchronization between your computer and the
SafeGuard Enterprise Server, the status dialog in the SafeGuard Enterprise system tray icon
indicates that your computer is Ready for certificate change.

The security officer provides you with the new token.
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To change the certificate on your computer:

1. Log on at the SafeGuard Power-on Authentication with your old authentication method (token
or user name/password) without automatic logon to Windows.

Click Options and clear the Pass through logon to Windows check box or log off again after
automatic logon to Windows has been performed.

2. Log on to Windows with the new token.

The new token is valid for SafeGuard POA logon. The old token is no longer valid for logon.

13.7 SafeGuard POA autologon with a token
Prerequisites:

■ USB support is activated in the BIOS.

■ Token support is initialized, and the token is issued.

■ The security officer has assigned the relevant policy to your computer.

If a policy with a defined default PIN has been assigned to your computer, you can automatically
log on at the SafeGuard Power-on Authentication by using a token.You do not have to enter any
credentials or PIN, but are passed through at the SafeGuard POA. Depending on your policy
settings, you may also be passed through to Windows.

To automatically log on at the SafeGuard Power-on Authentication using a token:

1. Plug in the token.

2. Switch on the computer.

You are automatically logged on at the SafeGuard Power-on Authentication. Depending on your
policy settings, you may also be passed through to Windows.

■ If autologon has been successful, Windows is started.

■ If autologon has failed, you are prompted to enter your token PIN.You are then logged on at
the SafeGuard Power-on Authentication.

13.8 Virtual keyboard
At the SafeGuard POA, you can show/hide a virtual keyboard on the screen, and click the on-screen
keys to enter credentials, etc.

Prerequisite: The security officer has activated the display of the virtual keyboard by policy.

To show the virtual keyboard in the SafeGuard POA, click Options in the POA logon dialog and
select the Virtual Keyboard check box.

The virtual keyboard supports different layouts. It is also possible to change the layout using the
same options used for changing the SafeGuard POA keyboard layout, see Change the keyboard
layout (page 68).
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13.9 Keyboard layout
Almost every country has its own keyboard layout. The keyboard layout in the SafeGuard POA
is very important when entering user names, passwords, and response codes.

By default, SafeGuard Enterprise adopts the keyboard layout which is set in the Windows Regional
and Language Options for the Windows default user at the time SafeGuard Enterprise is installed.

The language of the keyboard layout being used is displayed in the SafeGuard POA, for example
ENG for English. Apart from the default keyboard layout, you can also use the US keyboard layout
(English).

13.9.1 Change the keyboard layout

The SafeGuard Power-on Authentication keyboard layout (including the virtual keyboard layout)
can be changed.

1. Select Start > Control Panel > Regional and Language Options > Advanced.

2. On the Regional Options tab, select the required language.

3. On the Advanced tab, under Default user account settings, select Apply all settings to
the current user account and to the default user profile.

4. Click OK.

The SafeGuard POA recognizes the keyboard layout used for the last successful logon and
automatically enables it for the next logon. This requires two restarts. If the previous keyboard
layout is deselected in the Regional and Language Options, it is still maintained unless you
select a different one.

Note: You must also change the language of the keyboard layout for non-Unicode programs.

If the language you want is not available on your system, Windows may prompt you to install it.
After you have done so, you need to restart your computer twice so that, first, the new keyboard
layout can be read in by the SafeGuard POA and, secondly, the POA can set the new layout.

You can change the required keyboard layout for the SafeGuard POA by using the mouse or
keyboard (Alt+Shift).

To see which languages are installed and available on your system, select Start > Run > regedit:
HKEY_USERS\.DEFAULT\Keyboard Layout\Preload.

13.10 Hotkeys and function keys
Certain hardware functionality and settings can lead to problems when starting computers, causing
the system to no longer respond. The SafeGuard Power-on Authentication supports a number of
hotkeys for modifying these hardware settings and deactivating functionality. Furthermore, a
greylist of hardware settings and functionalities that are known to cause these problems is
integrated in the .msi file installed on the computer.

We recommend that you install an updated version of the SafeGuard POA configuration file prior
to any significant deployment of SafeGuard Enterprise. For more information, see Sophos
knowledgebase article 65700.
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You can customize this file to reflect the hardware of a particular environment.

Note: When you define a customized file, this will be used instead of the one integrated in the
.msi file. Only when no SafeGuard POA configuration file is defined or found will the default file
be applied.

To install the SafeGuard POA configuration file, enter the following command:

MSIEXEC /i <endpoint MSI package> POACFG=<path of the POA configuration
file>

The SafeGuard Power-on Authentication also supports a number of function keys.

13.10.1 Hotkeys

Shift - F3 = USB Legacy Support (on/off)

Shift - F4 = VESA graphic mode (off/on)

Shift - F5 = USB 1.x and 2.0 support (off/on)

Shift - F6 = ATA Controller (off/on)

Shift - F7  = USB 2.0 support only (off/on) USB 1.x support remains as set by Shift - F5.

Shift - F9 = ACPI/APIC (off/on)

Hotkeys dependency matrix

CommentUSB 2.0USB 1.xLegacyShift - F7Shift - F5Shift - F3

3.onononoffoffoff

Defaultononoffoffoffon

1., 2.offoffonoffonoff

1., 2.offoffonoffonon

3.offonononoffoff

offonoffonoffon

offoffonononoff

2.offoffonononon

1. Shift - F5 disables both USB 1.x and USB 2.0.

Note:  Pressing Shift - F5 during startup will considerably reduce the time it takes to launch
the SafeGuard POA. However, if your computer uses a USB keyboard or USB mouse, they
might be disabled when pressing Shift - F5.
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The POA may use the USB keyboard via BIOS SMM. There is no USB token support.

2. If no USB support is active, the SafeGuard POA tries to use BIOS SMM instead of backing
up and restoring the USB controller. The Legacy mode may work in this scenario.

3. Legacy support is active, USB is active. The SafeGuard POA tries to back up and restore the
USB controller. The system might hang depending on the BIOS version used.

Note: The changes that can be carried out using the hotkeys may already have been specified
during SafeGuard Enterprise endpoint installation using an .mst file.

When you change hardware settings by using the hotkeys in the SafeGuard POA, a dialog is
displayed prompting you to save the changed settings. This dialog shows an overview of the
configuration that will be saved.To save your changes, click Yes.When you restart your computer,
the new settings become active. If you click No, your changes are not saved, and the old
configuration remains active when you restart your computer.

By pressing F5 in any SafeGuard POA dialog, you can open a dialog showing the hotkeys
configuration used to start the POA. If hotkeys were changed during the startup, the relevant key
states are shown in blue. Blue means that the key was used in this state to start the SafeGuard
POA, but it has not been saved yet. Unchanged values are shown in black. To close the dialog,
press F5 again or press Return.

For more information, see Sophos knowledgebase article 107785.

13.10.2 Function keys in the logon dialog

Note: The function keys are not hotkeys.

F2 = abort Autologon.

F5 = displays a dialog showing the hotkey configuration used to start the SafeGuard POA.

F8 = change password in the SafeGuard POA. Use instead of the Enter key to trigger a password
change in the SafeGuard POA after logging on.

Alt + Shift (left-hand Alt and left-hand Shift keys) = change keyboard from German to English
(or the reverse).

Cancel and prepare SafeGuard POA for shutdown

Ctrl + Alt + Del = if authentication has failed but you need to shut down the computer safely. This
key combination has the same function as the Shutdown button.

Note:  If fingerprint logon is activated, you can use Ctrl + Alt + Del to change to the SafeGuard
POA dialog for logging on with a user name and password. For further information, see Logon
with the Lenovo Fingerprint Reader (page 71).

13.11 Password synchronization
SafeGuard Enterprise automatically detects when the Windows password has been changed and
no longer corresponds to the one stored in the SafeGuard Enterprise Database.This may happen
if the Windows password has been changed through a VPN on another computer, or in Active
Directory.
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If SafeGuard Enterprise detects this situation, you are prompted to enter the old password.
Afterwards, the password stored by SafeGuard Enterprise is updated with the new Windows
password.

Password synchronization will take place in the following two situations:

■ During the logon process.

■ During a Windows lock/unlock procedure.

13.12 Logon with the Lenovo Fingerprint Reader
Note:  Logon with the Lenovo Fingerprint Reader is only supported for Windows 7 (BIOS)
endpoints.

Users must remember many different passwords and PINs in order to access their computers,
applications, and networks. With a fingerprint reader, all you need to do is swipe your finger over
the reader to log on instead of using a password or token.

You can neither lose or forget your credentials, nor can unauthorized individuals guess this
information. Using fingerprint readers thus simplifies the logon process and increases security.

SafeGuard Enterprise supports fingerprint logon for SafeGuard Power-on Authentication as well
as the Windows logon phase. For example, you can log on to a Lenovo notebook simply by
swiping your finger over the fingerprint reader integrated into the notebook. The rest of the logon
procedure then runs automatically.You can also lock and unlock your desktop in Windows by
swiping your finger over the fingerprint reader.

Fingerprint readers are integrated directly into certain Lenovo notebooks.You can also use an
external USB keyboard for fingerprint logon.

Note:

■ Only one fingerprint reader may be connected to a computer at any given time.

■ Token and fingerprint logon procedures cannot be combined on the same computer.

■ Remote fingerprint logon is not supported.

13.12.1 Requirements

The following requirements must be met in order to use fingerprint logon.

General requirements
■ Lenovo Fingerprint Reader in the notebook or a USB keyboard with a fingerprint reader

■ Current BIOS (recommended)

■ SafeGuard Enterprise

■ The recommended vendor-specific software version must be installed before SafeGuard
Enterprise:

■ ThinkVantage Fingerprint for AuthenTec
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or

■ ThinkVantage Fingerprint for UPEK.

■ The security officer must have activated fingerprint logon by policy.

System requirements
■ Windows 7 (BIOS)

Supported hardware

For information on supported fingerprint logon hardware, see Sophos knowledgebase article
108789.

Supported software

For information on supported fingerprint software, see Sophos knowledgebase article 111626.

13.12.2 Enroll fingerprints

In order to log on to your notebook/PC with a fingerprint, you must first enroll one or more
fingerprints using the recommended vendor-specific software. The enrollment process links your
enrolled fingerprint with your credentials (user name and password).

Prerequisites: The following procedure assumes that both the recommended vendor-specific
software and SafeGuard Enterprise are installed.

1. Log on at the SafeGuard Power-on Authentication (POA) by entering your user name and
password.

2. Register one or more of your fingerprints by using the installed vendor-specific software. This
registration links your fingerprint with your Windows credentials.

a) Refer to the documentation for the ThinkVantage Fingerprint software for instructions on
how to enroll a fingerprint.

b) Enable the option POA password in BIOS. (UPEK only. For AuthenTec this step is not
necessary.)

c) To use fingerprint logon in the SafeGuard POA, you first have to log on to Windows once
with your fingerprint to transfer your credentials to the fingerprint reader. For UPEK you
only have to swipe an enrolled fingerprint over the fingerprint reader. For AuthenTec you
also have to enter your Windows password at first logon.

3. Restart your computer.

4. To test your enrolled fingerprint, swipe your finger over the fingerprint reader after restarting
the computer.

If your fingerprint matches the enrolled one, you are automatically logged on to Windows.
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13.12.3 Log on to SafeGuard Power-on Authentication with a fingerprint

Prerequisites:

■ The security officer must have set up the fingerprint option in the relevant Authentication
policy.

■ You must have enrolled one or more fingerprints.

1. Restart your computer.

The SafeGuard POA dialog for logging on with a fingerprint is displayed.

2. Swipe one of your enrolled fingers over the reader.

If the software recognizes your fingerprint, SafeGuard Power-on Authentication reads your
credentials and sends them to Windows.

Note: The logon procedure uses icons with short text messages as prompts, notifications,
and warnings, see Icons used in the logon process (page 73).

You are automatically logged on to Windows without any further requests for your data.

Note:

■ If the enrollment process in Windows was not completed successfully (for example, after
enrolling fingerprints, you have not logged off from and logged on again to Windows) a match
with the fingerprints enrolled will be found in the SafeGuard POA.

However, there will not be any credentials. In this case, an error message is displayed,
prompting you to log on with your user name and password, although this does not pass you
through to Windows.Your credentials are transferred to the fingerprint reader.

■ In the policies that apply to you, the security officer specifies whether pass-through to Windows
has been enabled or disabled and whether you can change these settings in the SafeGuard
POA dialog for logging on with a user name and password, see Log on with a user name and
password (page 76).

13.12.3.1 Icons used in the logon process
When you log on at the SafeGuard Power-on Authentication with a fingerprint, the system uses
icons as prompts, notifications, and warnings.These icons are displayed during the logon process,
along with a short text message.

Prompts you to swipe your finger over the fingerprint
reader.

Indicates that fingerprint logon is not currently
enabled.This can occur, for example, if the fingerprint
logon module has not yet been initialized.
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Indicates that the fingerprint reader is working and
is busy.

Indicates that the fingerprint was read successfully
and a match was found.

Indicates that the fingerprint was read successfully,
but no match was found.

Indicates that the fingerprint could not be read. Swipe
your finger across the fingerprint reader again.

Indicates that you have placed your finger too far to
the left (or too far to the right). Move your finger to
the center of the fingerprint reader.

Indicates that your finger swipe was too skewed.
Swipe your finger across the fingerprint reader again.
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Indicates that you moved your finger too fast. Swipe
your finger across the fingerprint reader again.

Indicates that your finger swipe was too short. Swipe
your finger across the fingerprint reader again.

13.12.3.2 Failed logon attempts
If the system is unable to read your fingerprint after five attempts, it considers this to be a failed
logon attempt and logs it as an event. In this case, a logon delay goes into effect.

If the system was able to read your fingerprint without errors, but did not find a match with the
registered fingerprint after five attempts, it also considers this to be a failed logon attempt and
logs it as an event. In this case, a logon delay also goes into effect.

The logon delay period increases with every failed logon attempt.
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13.12.3.3 Log on with a user name and password
Even if fingerprint logon is enabled, you can still log on at the SafeGuard Power-on Authentication
with your user name and password, for example, if your fingerprint reader does not work.

1. Press the Esc key or Ctrl+Alt+Del in the SafeGuard POA dialog for logging on with a fingerprint.

The SafeGuard POA dialog for logging on with a user name and password is displayed.

Note:  If you press Ctrl+Alt+Del in the SafeGuard POA dialog for logging on with a user name
and password, the computer shuts down. In this dialog, Ctrl+Alt+Del corresponds to the
Shutdown button.

The SafeGuard POA dialog for logging on with a user name and password is also displayed
automatically if a fingerprint reader is unavailable or if the system does not find any user data
on the fingerprint reader.

Note:  Logging on with a user name and password is also enabled automatically if the local
cache is corrupt. If this happens, your computer will be locked, and you must log on using a
Challenge/Response procedure.

2. Optionally, press Esc again to return to the SafeGuard POA dialog for logging on with a
fingerprint.

If you pressed Esc to switch to the SafeGuard POA dialog for logging on with a user name
and password, you can still log on by swiping your finger over the fingerprint reader without
having to return to the SafeGuard POA fingerprint logon dialog first.

13.12.4 Changing your password

1. If fingerprint logon is enabled in SafeGuard Power-on Authentication, you can change your
password in Windows by pressing Ctrl+Alt+Del.

When you change your password, the system prompts you to swipe your finger over the
fingerprint reader in order to transfer your new password to the fingerprint reader.

Note: Whenever you change your password, the change applies to all your enrolled fingerprints.

13.12.4.1 Synchronize your password
If your Windows password no longer matches the password stored on the fingerprint reader, for
example in cases where you changed your password, but the new password was not transferred
to the fingerprint reader, you can synchronize your password:

1. Restart your computer.

2. Press the Esc key or Ctrl+Alt+Del in the SafeGuard POA dialog for logging on with a fingerprint.

The SafeGuard POA dialog for logging on with a user name and password is displayed.

3. Click Options, and clear the Pass through logon to Windows check box.

Note:  In the policies that apply to you, the security officer specifies whether pass-through to
Windows has been enabled or disabled and whether you can change these settings in the
SafeGuard POA dialog for logging on with a user name and password.

4. Log on with your password.
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5. The Windows logon dialog is displayed. Swipe one of your enrolled fingers over the fingerprint
reader.

6. The system recognizes the fingerprint, but Windows rejects the password linked to the
fingerprint. This is not viewed as a failed logon attempt, however, so no logon delay goes into
effect.

A message indicating that the password was changed is displayed, and the system prompts
you to enter your current Windows password.

7. Enter the correct Windows password.

Note:  If you enter an incorrect Windows password here, a failed logon attempt is logged, and
a logon delay goes into effect. If you close the input prompt without entering a password, a
failed logon attempt is likewise logged, and a logon delay goes into effect.

A successful transfer of the password completes the password synchronization process and
you can then use the password for your logon.

13.12.5 Fingerprint logon recovery

If fingerprint logon does not work and you have forgotten the password required to log on,
SafeGuard Enterprise offers the following recovery methods:

■ Recovery with Local Self Help (page 48)

■ Challenge/Response for SafeGuard POA users (page 40)

The recovery methods available on your computer depend on the settings specified by the security
officer.

To initiate recovery, click the Recovery button in the fingerprint logon dialog.

Note:  Due to a recovery procedure, you may have to change your password when you start your
computer, for example if you have forgotten your password. In this case, the system also offers
to update your fingerprint credentials.

77

user help



14 Technical support
You can find technical support for Sophos products in any of these ways:

■ Visit the Sophos Community at community.sophos.com/ and search for other users who are
experiencing the same problem.

■ Visit the Sophos support knowledgebase at www.sophos.com/en-us/support.aspx.

■ Download the product documentation at www.sophos.com/en-us/support/documentation.aspx.

■ Open a ticket with our support team at
https://secure2.sophos.com/support/contact-support/support-query.aspx.
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15 Legal notices
Copyright © 1996 - 2017 Sophos Limited. All rights reserved. No part of this publication may be
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording or otherwise unless you are either a valid licensee where
the documentation can be reproduced in accordance with the license terms or you otherwise have
the prior permission in writing of the copyright owner.

Sophos, Sophos Anti-Virus and SafeGuard are registered trademarks of Sophos Limited, Sophos
Group and Utimaco Safeware AG, as applicable. All other product and company names mentioned
are trademarks or registered trademarks of their respective owners.

You find copyright information on third party suppliers in the Disclaimer and Copyright for 3rd
Party Software document in your product directory.
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